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Abstract

These Application Notes describe the steps for configuring Avaya IP Office 11.0 and Avaya
Session Border Controller for Enterprise 8.0 with the AT&T IP Toll Free service using AVPN
or MIS/PNT transport connections.

The AT&T IP Toll Free service is a managed Voice over IP (VolP) communications solution
providing toll-free services over SIP trunks for business customers.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as any observations noted in Section 2.2, to ensure that their own use
cases are adequately covered by this scope and results.

AT&T is a member of the Avaya DevConnect Service Provider program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps for configuring Avaya IP Office release 11.0 (Avaya
IP Office) and the Avaya Session Border Controller for Enterprise (Avaya SBCE) release 8.0
with the AT&T IP Toll Free service using AVPN or MIS/PNT transport connections.

Avaya IP Office is a versatile communications solution that combines the reliability and ease
of a traditional telephony system with the applications and advantages of an IP telephony
solution. This converged communications solution can help businesses reduce costs, increase
productivity, and improve customer service.

The Avaya Session Border Controller for Enterprise is the point of connection between Avaya
IP Office and the AT&T IP Toll Free service and is used to not only secure the SIP trunk, but
also to make adjustments to the SIP signaling and media for interoperability.

The AT&T IP Toll Free service is a managed Voice over IP (VoIP) communications solution
providing toll-free services over SIP trunks for business customers. The AT&T Toll Free service
utilizes AVPN? or MIS/PNT? transport services.

Note — The AT&T IP Toll Free service will be referred to as IPTF in the remainder of this
document.

Note — The solution described in these application notes also applies to the AT&T Business in a
Box service.

L AVPN uses compressed RTP (CRTP).
2 MIS/PNT does not support cRTP.
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2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

The interoperability compliance testing focused on verifying inbound and outbound call flows
between IPTF and the Customer Premises Equipment (CPE) containing the Avaya SBCE and
Avaya IP Office (see Section 3.2 for call flow examples).

The test environment described in these Application Notes consisted of:
e Asimulated enterprise with Avaya IP Office 11.0, Avaya SBCE 8.0, Avaya SIP, H.323,
Digital and Analog telephones, as well as a fax machine emulator (Ventafax).
e Laboratory versions of the IPTF service, to which the simulated enterprise was connected
via AVPN/MIS transport.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between Avaya systems and
the AT&T Toll Free service did not include use of any specific encryption features as requested
by AT&T.

Encryption (TLS/SRTP) was used internal to the enterprise between Avaya products wherever
possible.
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2.1. Interoperability Compliance Testing

The compliance testing was based on a test plan provided by AT&T, for the functionality
required for certification as a solution supported on the IPTF network. Calls were made from the
PSTN across the IPTF test network, to the CPE.

The interoperability compliance testing focused on verifying inbound call flows (see Section
3.2) between Avaya IP Office, Avaya SBCE and the IPTF service.

The compliance testing was based on a test plan provided by AT&T, for the functionality
required for certification as a solution supported on the AT&T network.

The following SIP trunking VolP features were tested with the IPTF service:

Incoming calls from PSTN, routed by the IPTF service, to the Avaya SBCE and the
Avaya IP Office. These calls are via the Avaya IP Office SIP Line and may be
generated/answered by Avaya SIP telephones/Softphones, H.323 telephones, Analog
telephones, Digital telephones, Analog fax machines or via Hunt Groups. Coverage to
Voicemail Pro, and Voicemail Pro auto-attendant applications, were also used.

Inbound fax using T.38 or G.711, and G3 or SG3 endpoints.

Proper disconnect when the caller abandons a call before answer, and when the Avaya IP
Office party or the PSTN party terminates an active call.

Proper busy tone heard when an Avaya IP Office user calls a busy PSTN user, or a PSTN
user calls a busy Avaya IP Office user (i.e., if no redirection was configured for user busy
conditions).

SIP OPTIONS monitoring of the health of the SIP trunk. In the reference configuration
Avaya IP Office sent OPTIONS to the IPTF service Border Element and AT&T
responded with 405 Method Not Allowed (which is the expected response). That response
is sufficient for Avaya IP Office to consider the connection up.

Incoming calls using the G.729A and G.711 ULAW codecs.

Long duration calls.

DTMF transmission (RFC 2833) for successful voice mail navigation, including
navigation of a simple auto-attendant application configured on Voicemail Pro, as well as
IPTF DTMF generated features.

Telephony features such as call waiting, hold, transfer, and conference.

Avaya Remote Worker configuration (Avaya Equinox SIP softphone) via Avaya SBCE.
Verify reception of IPTF SIP Multipart/NSS headers, including SDP and XML content.
AT&T IP Toll Free features such as Legacy Transfer Connect and Alternate Destination
Routing.
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2.2. Test Results
The test objectives stated in Section 2.1, with limitations as noted below, were verified.

1.

Avaya IP Office only supports a packet size (ptime) of 20 msecs — Although no issues
were found during testing, AT&T recommends that for maximum customer bandwidth
utilization, a ptime value of 30 should be specified.

IP Toll Free ADR Call Redirection feature based on SIP error code response — Upon
receiving an error response, IPTF service can be configured to invoke ADR Call
Redirection. The following error codes were producible by the reference configuration
and tested successfully; 408 Request Timeout, 480 Temporarily Unavailable, 486 Busy
Here, and 503 Service Unavailable. The following error codes are also supported by IPTF
service, but were not producible by the reference configuration, and thus not tested; 500
Server Internal Error, 504 Server Timeout, and 600 Busy Everywhere.

Enhanced CID — NSS feature. The inbound calls to Avaya IP Office are not exercising
the Enhanced CID feature. Although Avaya IP Office is accepting SIP Multipart/NSS
headers, it is neither passing nor acting upon it. It is simply being ignored.

IP Office determines the codec priority — IP Office will follow the codec priority based
on the Codec Selection on the SIP Line VolP tab, see Section 5.5.5. It will not follow the
codec priority set by the IPTF service.

Codec G.729B is not supported on IP Office Server Edition server — Specific test
cases on the AT&T Test Plan requiring the use of codec G.729B at the CPE could not be
executed. Codec G729B is not supported on SIP trunks terminating on the Avaya IP
Office Server Edition Linux server platform, as deployed on the test configuration.
Codec G.729B is supported when the SIP trunk is terminated on an IP Office IP500 V2
standalone or expansion system.

Inbound User-to-User Information is not supported with IP Office — User-to-User
Information (UUI) is not supported on inbound SIP trunk calls. IP Office is able to
successfully receive an inbound call from AT&T containing UUI, but the UUI data is
simply ignored.

Inbound T.38 or G.711 fax calls fail when the sender and receiver are both Super
G3 (SG3) fax devices — During testing it was found that when the sender and receiver
both used SG3 fax devices, and an inbound fax call was placed to Avaya IP Office
using either T.38 or G.711, the fax calls failed to connect. SG3 speeds (33600 bps),
should be disabled on the CPE fax device if possible.
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8. G.711 fax calls fail when the initial voice call is setup at codec G.729A — While testing
inbound fax calls in G.711 pass-through mode, it was found that Avaya IP Office will not
send a re-INVITE to renegotiate to codec G.711, in cases where the initial voice call was
negotiated using codec G.729A. The fax call will fail in this scenario. This issue is
currently under investigation by Avaya.

2.3. Support

AT&T customers may obtain support for the AT&T IP Toll Free service by calling (800) 325-
5555.

Avaya customers may obtain documentation and support for Avaya products by visiting:
http://support.avaya.com. In the United States, (866) GO-AVAYA (866-462-8292) provides
access to overall sales and service support menus. Customers may also use specific numbers
(provided on http://support.avaya.com) to directly access specific support and consultation
services based upon their Avaya support agreements.

3. Reference Configuration

Note — Documents used to provision the test environment are listed in Section 11. References to
these documents are indicated by the notation [x], where x is the document reference number.

The reference configuration used in these Application Notes is shown in Figure 1 on the next

page and consists of the following components:

e Avaya IP Office provides the voice communications services for a particular enterprise site.
In the reference configuration, Avaya IP Office runs on the Avaya IP Office Server Edition
platform. Note that this solution is extensible to deployments using the standalone IP500 V2
platform as well.

e In the sample configuration, the Primary server runs the Avaya IP Office Server Edition
Linux software. Avaya VVoicemail Pro, running as a service on the Primary Server, provided
the voice messaging capabilities in the reference configuration.

e The Expansion System (V2) is used for the support of digital, analog and additional IP
stations. It consists of an Avaya IP Office 500 V2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module).

e Avaya endpoints are represented with an Avaya 9608 H.323 Deskphone, Avaya J169 SIP
Deskphones, an Avaya 1140E SIP Deskphone, an Avaya 9508 Digital Deskphone, as well as
Avaya Equinox for Windows (SIP) softphone. Fax endpoints are represented by PCs running
Ventafax emulation software connected by modem to an Avaya IP Office analog port.

e The Avaya SBCE provides SIP Session Border Controller (SBC) functionality, including
address translation and SIP header manipulation between the IPTF service and the CPE. In
the reference configuration, the Avaya SBCE runs on a VMware platform. This solution is
extensible to other Avaya Session Border Controller for Enterprise platforms as well.
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e The Avaya IP Office and the Avaya SBCE used in the reference configuration were deployed
using the following configuration.
o IP Office LANL1 interface connected to the CPE private network.
o Avaya SBCE Al interface connected to the CPE private network.
o Avaya SBCE B1 interface connected to the AT&T network.

e TLS/5061 is the recommended transport protocol/port to use on the Avaya IP Office LAN1
connection to the Avaya SBCE Al interface. However, TCP/5060 may be used for this
connection if desired.

e UDP transport via port 5060 was used between the Avaya SBCE and AT&T.

e The AT&T IPTF service requires RTP port ranges 16384-32767.

e AT&T provided the inbound and outbound access numbers (DID and DNIS) used in the
reference configuration. Note that the IPTF service may deliver various digit lengths in the
SIP Invite Request-URI depending on the circuit order provisioning. In the reference
configuration, the IPTF service delivered 10 digits.

r Y

ATET
,.--""H

ATAT
nr_&rmrNﬁungﬂr i Vo Frus

e i,

ATET Router Bovaya Equine for

Enterprise Site

Figure 1: Test Configuration
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An Avaya Remote Worker endpoint (Avaya Equinox for Windows) was used in the reference
configuration. The Remote Worker endpoint resides on the public side of an Avaya SBCE (via a
TLS connection), and registers/communicates with IP Office as though it was an endpoint
residing in the private CPE space.

Note — The configuration of the Remote Worker environment is beyond the scope of this
document. Refer to [9] on the Additional References section for information on Remote Worker
deployments.

3.1. lllustrative Configuration Information

The specific values listed in Table 1 below and in subsequent sections are used in the reference
configuration described in these Application Notes and are for illustrative purposes only.
Customers must obtain and use the values based on their own specific configurations.

Note — The Avaya SBCE “B1” interface communicates with AT&T Border Elements (BEs)
located in the AT&T IPTF network. For security reasons, the IP addresses of the AT&T BEs are
not included in this document. However, as placeholders in the following configuration sections,
the IP addresses 192.168.80.43 (Avaya SBCE “B1”), and 192.168.225.210 (AT&T BE address),
are specified. In addition, AT&T DID/DNIS numbers shown in this document are examples as
well. AT&T Customer Care will provide the actual Border Element IP addresses and DID/DNIS
numbers as part of the IPTF provisioning process.

Component Ilustrative Value in these Application
Notes
Avaya IP Office
Primary Server, LAN1 interface 10.64.19.170
Expansion System, LAN1 Interface 10.5.5.180
Avaya SBCE
“Inside Interface”, Al 10.64.91.41
“Outside” Interface, B1 192.168.80.43
AT&T IPTF Service
Border Element IP Address | 192.168.225.210

Table 1: Hlustrative Values Used in these Application Notes
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3.2. Call Flows

To understand how inbound and outbound AT&T IPTF service calls are handled by Avaya IP
Office, two basic call flows are described in this section.

3.2.1. Basic Inbound

The first call scenario illustrated in the figure below is an inbound AT&T IPTF service call that
arrives on Avaya IP Office, which in turn routes the call to a hunt group, phone or a fax
endpoint.

A PSTN phone originates a call to an IPTF service number.

The PSTN routes the call to the AT&T IPTF service network.

The AT&T IPTF service routes the call to the Avaya SBCE.

The Avaya SBCE performs SIP Network Address Translation (NAT) and any specified
SIP header modifications, and routes the call to Avaya IP Office.

5. Avaya IP Office applies any necessary digit manipulations based upon the DID and
routes the call to a hunt group, phone or a fax endpoint.

el N =

PSTN
Phone1

Avaya
ﬁ" ° IP Office

Figure 2: Inbound AT&T IPTF Call
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3.2.2. Coverage to Voicemalil

The call scenario illustrated in the figure below is an inbound call that is covered to Voicemail.
In the reference configuration, the VVoicemail system used is Voicemail Pro, running on the
Application Server.

1. Same as the first call scenario in Section 3.2.1.
2. The Avaya IP Office phone does not answer the call, and the call covers to the external
application Avaya IP Office VVoicemail Pro.

@ —1

PSTN
Phone1

IP Toll Free Service

Voicemail Pro | g o |

Phone

Figure 3: Coverage to Voicemail (Voicemail Pro)
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment/Software

| Release/Version

Avaya

Avaya IP Office Server Edition
- Avaya IP Office Voicemail Pro

Release 11.0.4.1.0 Build 11
Release 11.0.4.0.0 Build 2

Avaya IP Office 500 V2 Expansion System

Release 11.0.4.1.0 Build 11

Avaya IP Office Manager

Release 11.0.4.1.0 Build 11

Avaya Session Border Controller for Enterprise

Release 8.0.0.0-19-16991

Avaya 96x1 Series IP Deskphone (H.323) Release 6.8002
Avaya 1140E IP Deskphone (SIP) Release 04.04.23.00
Avaya J129 IP Deskphone (SIP) Release 4.0.0.21
Avaya J169 IP Deskphone (SIP) Release 4.0.0.21
Avaya 9508 Digital Deskphone Release 0.60

Avaya Equinox for Windows Release 3.6.0.153.36

Avaya Fax device

Ventafax 7.10

Table 1: Equipment and Software Versions

Note — Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2, and also when deployed with all configurations of IP Office Server Edition. IP Office
Server Edition requires an Expansion IP Office 500 V2 to support analog or digital endpoints or

trunks.
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5. Avaya IP Office Primary Server Configuration

Avaya IP Office is configured through the Avaya IP Office Manager application. From the PC
running the IP Office Manager application, select Start = Programs - IP Office = Manager

to launch the Manager application. Log in using the appropriate credentials.

B Select IP Office — [m}
Mame IP Address  Type Version Edition

Server Edition 11.0
IPOSE-Primary 10.64.18.170  IPO-Linux-PC  11.0.4.1.0 build 11 Server (Primary) Select

Configuration Service User Login

IP Office: IPQSE-Primary (Primary System - [PO-Linux-PC)

Service User Name |Adm|n|strator |

Service User Password |"nnoun| |

Cancel Help

TCP Discovery Progress

Unit/Broadcast Address

10.64.18.170 ~

Refresh

Ee

On Server Edition systems, the Solution View screen will appear, similar to the one shown below.
All the Avaya IP Office configurable components are shown in the left pane, known as the
Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g., IPOSE-
Primary, on the navigation pane will expand the menu on this server.

Configuration

= Server Edition

-

R BOOTP (3)
({7 Operator (3)
4% Solution

§ User(49)
-4k Group(7)
-8R Short Code(60)
- Directory(2)

£ Time Profile(0)
-8l Account Code(1)
-§i User Rights(1)
5 Location(7)

-39 |POSE-Primary
~#33 |POSE-Secondary
=7 IP500 Expansion

~%3) Los Angeles
-0 New Jersey

-5 Thorntan

Summary

_ Server Eton Frmary

B Hardware Instalied

Control Unit: IPO-Linux-PC

Secondary Server: 10.64.19.175

Expansion Systems: 10.64.19.66; 10.64.19.67; 10.64.19.68; 10.5.5.180

System Identification: 0cfd4522c51b0c32bf82b48a633645159a160450
B System Settings

IP Address: 10.64.19.170

Sub-Met Mask: 25 255.0

Systemn Locale: United States (US English)

Systermn Location: 2: Denver

Device ID: NONE

Number of Extensions on System: 18

Open...
@ Configuration

-
'J- System Status

@ Resiliency Administration

& On-boarding
1‘ IP Office Web Manager

@ tep

—:;\ Set All Nodes License Source

Add...

s, Secondary Server

*s, Expansion System
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In the screens presented in the following sections, the View menu was configured to show the
Navigation pane on the left side, the Group pane in the center and the Details pane on the right
side. These panes will be referenced throughout the rest of this document.

Standard feature configurations that are not directly related to the interfacing with the service
provider are assumed to be already in place, and they are not part of these Application Notes.

5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

In the reference configuration, IPOSE-Primary was used as the system name of the Primary
Server and 1P500 Expansion was used as the system name of the Expansion System. All
navigation described in the following sections (e.g., License) appears as submenus underneath
the system name in the Navigation Pane.

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status
for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the
number of channels provisioned for the SIP trunk.

Configuration | License

R BOOTP (3) License Type  Status
“ Operator (3)
=} Solution License Mode
@ User(49)

3§ Group(?)
% Short Code(60)
--om Directory(2)
£ Time Profile(0)

License  Remote Server

WebLM Mormal
Licensed Version 11.0

Select Licensing  Valid

@ Account Code(1) Feature Instances Status Expiration Date Source
ﬁ, User Rights{1) Additional Voicemail Pro Ports 152 Valid Mever WebLM
@ Location(7) VMPro TTS Professional 1 Valid Never WebLM
i 'PozE'f”m;")Y Pawer User 16 Valid Never WebLM
...... 2 Systern
wo L?rne (14) Avaya P endpoints 18 Valid Mever WebLM
._ Control Unit (9) SIP Trunk Channels o Valid Mever WebLM
-4 Extension (18) CTl Link Pro 1 Valid Mewver WebLM
@ User(22) Server Edition 1 Valid Never WebLM
::ﬁ ;?t'tpc(“]d . Web Collaboration 2 Valid Never WebLM
-® SerovicE?D)e UMS Web Services 1 Valid Never WebLM
B Incoming Call Ro VM Media Manager 1 Valid Mewver WebLM
- [ill IP Route (3)
S License (10)
-~ ARS (12)
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5.2. TLS Management

For the compliance test, the signaling on the SIP trunk between IP Office and the Avaya SBCE
was secured using TLS. Testing was done using identity certificates signed by a local certificate
authority SystemManager CA. The generation and installation of these certificates are beyond
the scope of these Application Notes. However, once the certificates are available they can be
viewed on IP Office in the following manner.

To view the certificates currently installed on IP Office, navigate to File > Advanced -
Security Settings. Log in with the appropriate security credentials (not shown). In the Security
Settings window, navigate to Security = System and select the Certificates tab.

To verify the identity certificate, locate the Identity Certificate section and click View to see the
details of the certificate.

System: [IPOSE-Primary
System Details Unsecured Intefaces  Certificates
Identity Cerificate

Offer Certificate i
Offer ID Certficate Chain ]
lssued To: silipose customer.com

Set Wiew Regenerate

Certificate Expiny Waming Days 60 =

Lse Different Identity Certificate For SIP Telephony MNone w

Received Cerificate Checks (Management Inteffaces) MNone ~

Received Certificate Checks (Telephony Endpoints) MNone v

Trusted Certificate Store
Installed Certificates System Manager CA
Symarntec Class 3 Secure Server CA - G4

VeriSign Class 3 Intemational Server CA -G3
SIP Product Certificate Authority
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5.3. System Settings

This section illustrates the configuration of system settings. Select System on the Navigation
pane to configure these settings. The subsection order corresponds to a left to right navigation of
the tabs in the Details pane for System settings. For all the following configuration sections, the
OK button (not shown) must be selected in order for any changes to be saved.

5.3.1. LAN1 Tab

In the sample configuration, LAN1 is used to connect the Primary Server to the enterprise private
network.

To view or configure the LAN 1 IP address and subnet mask, select the LAN1 - LAN Settings
tab and enter the information as needed, according to customer specific requirements:

e IP Address: 10.64.19.170 was used in the reference configuration.

e IP Mask: 255.255.255.0 was used in the reference configuration.

e Click the OK button (not shown).

Configuration | System i= IPOSE-Primary
’!' BOOTP (3] Name System LANT  LAN2  DNS Voicemail Telephony Directory Services System Events SMTP
i Operator (3) % |POSE-Primary :
=27 Solution LAN Settings  VolP Network Topology
----- § User(9)
..... 8 Group(n) IP Address 10 64 19 . 170
----- 8% Short Code(60)
- Directory(2) IP Mask 255 . 255 . 255 0
£ Time Profile()
----- Bl Account Code(1)
""" fis UserRights(1) Mumber Of DHCP IP Addresses |34 =
B Location(7)
' IPOSE-Primary DHCP Mede
5 = System (1) O Server (O Client (® Disabled Advanced
1 Line (14)
= Control Unit (9]
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Select the LAN1 - VolIP tab as shown in the following screen. The following settings were
used in the reference configuration:

e The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones
using the H.323 protocol, such as the Avaya 96x1-Series Deskphones used in the
reference configuration.

e The H.323 Signaling over TLS should be set based on customer needs. In the reference
configuration it was set to Preferred.

e The SIP Trunks Enable parameter must be checked to enable the configuration of SIP
trunks to AT&T.

e The SIP Registrar Enable box was checked to allow Avaya J100-Series Deskphones,
Avaya 1100-Series Deskphones and Avaya Equinox usage.

e The Domain Name and SIP Registrar FQDN may be set according to customer
requirements. The values used in the reference configuration are shown.

e Set the Layer 4 Protocol section based on customer needs. In the reference configuration
TCP/5055 and TLS/5056 were configured.

System LANT | aAN2  DNS Woicemail Telephony Directory Services System Events SMTP  SMDR VolP Contact Center  Avaya Cloud Services
LAM Settings VoIP  Network Topolegy

H.323 Gatekeeper Enable

Auto-create Extenszion Auto-create User [] H.323 Remote Extension Enable

H.323 Signaling over TLS 1720 E

SIP Trunks Enable

SIP Registrar Enable

Auto-create Extension/User 5IP Remote Extension Enable  Allowed SIP User Agents | Block blacklist enly v
SIP Domain Mame |5i“P°59-CU5t°mE'-C°m |
SIP Registrar FODM |5i|ip05e.customer.com |

0 uop UDP Port |5060 S Remate UDP Port | 5060 5
Layer 4 Protocol TCP TCP Port 3035 2 Remote TCP Port 5035 2
LS TLSPort (3036 5 Remote TLS Port (3056 :

Challenge Expiration Time (sec) 10 5

RTP
Port Number Range

Minimurm 40750 = Maxirnurn 50750 S
Port Number Range (NAT)
Minimum 40750 = Maximum 50750 =
L
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Scroll down the page:

e Verify the RTP Port Number Range. Based on this setting, Avaya IP Office will
request RTP media to be sent to a UDP port in the configurable range for calls using
LAN1. The Minimum and Maximum port numbers were kept at their default values in
the reference configuration.

e Inthe Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout to 30
and the Initial keepalives parameter to Enabled. This is done to prevent possible issues
with network firewalls closing idle RTP channels.

e Inthe DiffServ Settings section, IP Office can be configured to mark the Differentiated
Services Code Point (DSCP) in the IP Header with specific values to support Quality of
Services (QoS) policies for both signaling and media. The DSCP field is the value used
for media, while the SIG DSCP is the value used for signaling. These settings should be
set according to the customer’s QoS policies in place. The default values used during the
compliance test are shown.

e Click OK to commit (not shown).

Contact Center Avaya Cloud Services

System LANT  LAN2  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR VolP

LAM Settings  VeIP Metwork Tepology

RTP
Port Number Range
Minimum 40750 = Maximum 50750 =
Port Murnber Range (MAT)
Minirnum 40730 = Maximum 30730 >

Enable RTCP Menitoring on Port 5005

RTCP collector IP address for phones 0

Keepalives

Scope RTP-RTCP ~ | Periodic timeout

Initial keepalives |Enabled v

DiffServ Settings

B8 |*| DSCP(Hex) B8  |3| Video DSCP(Hex) FC 3] DSCP Mask (Hex) 28 2 SIG DSCP (Hex)
46 *| Dsce 46 | Video DSCP 63 *| DSCP Mask 34 2| siG Dsce
DHCP Settings

Primary Site Specific Option Nurber (4600/5600) 176

Ale| e

Secondary Site Specific Option Nurnber (1600/9600) 242
VLAN Not Present ~

1100 Voice VLAN Site Specific Option Number (SSON) 232 =

1100 Veice VLAN IDs
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Select the LAN1 - Network Topology tab as shown in the following screen, and enter the
following:
e Firewall/NAT Type was set to Unknown in the reference configuration.
e The Public IP Address and Public Port sections are not used for the AT&T IPTF SIP
trunk service connection.
e Click the OK button (not shown).

Systern  LAMT  |AN2  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR VolP Contact Center Avaya Cloud Services
LAM Settings  VolP Network Topology

Metwork Topology Discovery

STUM Server Address STUN Port 3478 >
Firewall/NAT Type Unknown ~
Binding Refresh Time (sec) 60 =
Public IP Address 0 0 0 0 Run STUN Cancel
Public Port

upp 0 =

TCP 0 =

TS 0 =

[] Run STUN on startup
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5.3.2. Voicemail Tab

As described in Section 3, Voicemail Pro was used in the reference configuration.
e Set Voicemail Type to Voicemail Lite/Pro.
e Set Voicemail IP Address to the IP address of the server hosting voicemail. In the
reference configuration, this is the Primary server, 10.64.19.170.
e Other parameters on this screen are default. Click the OK button (not shown).

System LANT1 LAN2 DNS Voicemail Telephony Directory Services System Events SMTP  SMDR  VolP VolP Security Contact Center

~
Voicemail Type Voicemail Lite/Pro Messages Butten Goes Te Visual Voice
Voicemail Destination Outcalling Control
Yoicemail IP Address 10 64 19 170

Backup Voicemail IP Address | 10 64 19 175

Veicemail Channel Reservation

Unreserved Channels

Auto-Attendant 0 2 VoiceRecording |0

Mandatory Voice Recording |0 =

Anncuncements 0 + Mailbox Access |0 =

5.3.3. Telephony Tab

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as
shown in the following screen. The settings presented here simply illustrate the values used in
the reference configuration and are not intended to be prescriptive.
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e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and
call transfers to the PSTN via the SIP trunk to the service provider. If for security reasons
incoming calls should not be allowed to transfer back to the PSTN, then leave this setting

checked.

e Set the Companding Law parameters to U-Law as is typical in North America.

e Default values are used in the other fields.
e Click the OK button (not shown).

System LAMT  LAN2 DNS Voicernail Telephony  Directory Services  System Events SMTP SMDR  VoIP Contact Center Avaya Cloud Services

Telephony  Park & Page Tones & Music Ring Tones SM

Dial Delay Time (sec) 4 o
Dial Delay Count 0 o
Default Mo Answer Time (sec) 13 =
Hold Timeout (sec) 0 =
Park Timeout (sec) 0 =
Ring Delay (sec) 5 S

Call Priority Promotion Time (sec) |Disabled

Default Currency usD ~
Default Name Pricrity Favor Trunk ~
Media Connection Preservation Enabled ~
Phone Failback Automatic ~

Login Code Complexity
[ Enforcement

Minimum length |6 o
Complexity

RTCP Cellector Cenfiguration
[ Send RTCP to an RTCP Collector

Companding Law

Switch Line
® U-Law (® U-Law Line
) A-law () A-Law Line

[] Dss Status
Auto Hald

Dial By Name
Show Account Code
[ Inhibit Off-Switch Ferward/Transfer
[1 Restrict Metwork Interconnect

Include location specific information

[] Drop External Only Impromptu Conference
Visually Differentiate External Call

High Quality Conferencing
Directory Overrides Barring

Advertise Callee State To Internal Callers

[] Internal Ring on Transfer
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5.3.4. VoIP Tab

Navigate to the VoIP tab in the Details pane to view or change the system codecs and VolP
security settings.

Select the VolP - VolP tab. Configure the following parameters:

e The RFC2833 Default Payload field allows for the manual configuration of the payload
type used on SIP calls that are initiated by the IP Office. During the compliance test, this
was set to 100, the value preferred by AT&T.

e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323)
will use the system default codec selection shown here, unless configured otherwise for a
specific line or extension. The example below shows the codecs used for IP phones (SIP
and H.323), the system’s default codecs and order were used.

e Click OK to commit (not shown).

Systemn  LAMT  LAMZ  DNS Voicernail Telephony Directory Services Systerm Events  SMTP  SMDR  VelP Contact Center  Avaya Cloud Services
ValP VolP Security Access Control Lists
Ignore DTMF Mismatch Fer Phones O

Allow Direct Media Within NAT Location [

RFC2833 Default Payload 100 =
Available Codecs Default Codec Selection
Unused Selected
G.711 LULAW B4k G717 ALAW 64K S G.722 64K
G.711 ALAW 64K G.717 ULAW 64K
G.722 64K 5.729(a) 8K CS-ACELP

G.729(a) BK C5-ACELP

£ L
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During the compliance test, SRTP was used internal to the enterprise wherever possible. To view
or configure the media encryption settings, select the VolP = VoIP Security tab on the Details
pane.
e Set the Media Security drop-down menu to Preferred to have IP Office attempt use
encrypted RTP for devices that support it and fall back to RTP for devices that do not
support encryption.

e Under Media Security Options, select RTP for the Encryptions and Authentication
fields.

e Under Crypto Suites, select SRTP_AES_CM_128 SHA1 80.
e Click OK to commit (not shown).

System LAM1  LAMZ  DNS Voicemail Telephony Directory Services System Events SMTP  SMDR  VolP Contact Center  Avaya Cloud Services
VolP VolP Security  Access Contral Lists

Default Extension Password | |

Confirm Default Extension Password | |

Media Security | Preferred ~ [[] Strict SIPS
Media Security Options
Encryptions RTP
[ RTCP
Authentication RTP

RTCP
Replay Protection

SRTP Window Size 64

Crypto Suites

SRTP_AES_CM_128_SHA1_80
[] SRTP_AES_CM_128_SHA1_32
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5.4. IP Route

In the sample configuration, the IP Office LAN1 port is physically connected to the local area
network switch at the IP Office customer site. The Avaya SBCE resides on a different subnet and

requires an IP route to allow SIP traffic between the two devices.

To create a new IP route, right-click on IP Route on the left navigation pane. Select New (not

shown).

e Setthe IP Address and IP Mask of the subnet of the private side of the Avaya SBCE, or

enter 0.0.0.0 to make this the default route.

e Set Gateway IP Address to the IP Address of the router in the IP Office subnet. The

default gateway for this network is 10.64.19.1.
e Set Destination to LAN1 from the pull-down menu.
e Click OK to commit (not shown).

Configuration | 0.0.0.0

ERCIREIR2AEEE

=-& BOOTP (3) ~ | IPRoute
B¢ Operator (3)
-39 Solution IP Address 0 0 0 0

@
=43 Group(7)
8% Short Code(50)
- Directory(2)
L7 Time Profile(0) Destination LANT
8| Account Code(1)
i iy User Rights(1) Metric 0
i B Location(7)

1P Mask o 0 0 0

Gateway IP Address 0 64 19 1

@ User (22)

£] ﬂ Group (4)

-8 Short Code (10)
B Service (0)

-3 Incoming Call Route (61)
1]

i)
~%ez Licence (10
=g ARS (12)
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5.5. SIP Line

The following sections describe the configuration of a SIP Line. The SIP Line terminates the
CPE end of the SIP trunk to the AT&T IPTF service.

The recommended method for creating/configuring a SIP Line is to use the template associated

with the provisioning described in these Application Notes. The template is an .xml file that can
be used by Avaya IP Office Manager to create a new SIP Line for SIP trunking with the AT&T
IPTF service. Follow the steps in Section 5.5.1 to create a SIP Trunk from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP trunk registration credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.5.2 to 5.5.6.

In addition, the following SIP Line settings are not supported on Basic Edition:

SIP Line — Originator number for forwarded and twinning calls.
Transport — Second Explicit DNS Server.

SIP Credentials — Registration Requirement.

SIP Advanced Engineering.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.5.2
to 5.5.6.
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5.5.1. Creating a SIP Line from an XML Template

Note — DevConnect generated SIP Line templates are always exported in an XML format.
These XML templates do not include sensitive customer specific information and are
therefore suitable for distribution. The XML format templates can be used to create SIP
trunks on both IP Office Standard Edition (IP500 V2) and IP Office Server Edition systems.
Alternatively, binary templates may be generated. However, binary templates include all the
configuration parameters of the Trunk, including sensitive customer specific information.
Therefore, binary templates should only be used for cloning trunks within a specific
customer’s environment.

Copy a previously created template file to the computer where IP Office Manager is installed. To
create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then navigate
to New ->New from Template. Select Open from file.

| T T i —

& |POSE-Prid J Mew ’

S Systen
T
Contrg
Ay Extens
f Useriz
; 5":“‘:‘
X Short ¢
@ Servicy —
E ;{F!!:‘QI'E I Mew from Tem Plﬂt » I.'}Pt-n from file
B Licens Show In Groups
£ ARS(1
BB Locatiy
88 Authorization Code (0) [

Customize Columns...

Navigate to the directory where the template was copied on the local computer (e.g., \temp) and
select it. Click Open (not shown).

%" Open x
<« v A » ThisPC » Avaya eSOE (C:) » temp v O Search temp 02
Organize v Mew folder - @ @
~
&= Pictures " Mame Date modified Type Size
B videos [ New-Templatexml 4/17/20199:29 AM XML Document 7KB
> 2o Avaya eSOE (C)
wa USB Drive (D)

The new SIP Line is created, and it will appear on the Navigation pane (e.g., SIP Line 15). The
resulting SIP Line data can be verified against the manual configuration shown in Sections 5.5.2
t0 5.5.6.

Line

Line Mumber Line Type Line SubType
8 IP Office Line  WebSocket Server SCN
" 10 5IP Line

=15 SIP Line
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5.5.2. SIP Line — SIP Line tab
On the SIP Line tab in the Details pane, configure or verify the parameters as shown below:

ITSP Domain Name: leave as the default (blank) to have IP Office send the ITSP Proxy
Address as the domain name. See Section 5.5.3.

Local Domain Name: Set to the public IP address of the Avaya IP Office LAN1
interface (e.g., 10.64.19.170).

Verify that In Service box is checked, the default value. This makes the trunk available
to incoming and outgoing calls.

Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.

Refresh Method: Set to Re-Invite, as AT&T does not support UPDATE

Set Timer (seconds) to 1800. This field specifies the session expiry time. With this
value, a session refresh message is sent every 15 minutes, at the half way point of the
expiry time.

Incoming Supervised Refer: Set this field to Auto (default).

Outgoing Supervised Refer: Set this field to Auto (default).

Send 302 Moved Temporarily: Verify this is unchecked (default).

Outgoing Blind Refer: Verify this is unchecked (default).

Use the default values for the other fields.

Click OK (not shown).

5IP Line Transport Call Details VolP  SIP Credentials SIP Advanced Engineering

Line Mumber

ITSP Domain Name

15

In Service

Check 005

Local Domain Name |1D.64.19.1?D |
URI Type SIP URI - Session Timers
Location Cloud w Refresh Method Reinvite ~
Timer (seconds) 1800 =
Prefix | |
National Prefix o |
International Prefix [0 |
Country Cade | | Redirectand Transfer
Name Priority System Default > Incoming Supervised REFER Auto -
Description |SBCEtD ATET IPTF | Outgoing Supervised REFER Auto »
Send 302 Moved Temporarily ~ []
Outgoing Blind REFER O
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5.5.3. SIP Line - Transport Tab
Select the SIP Line - Transport tab and configure the following:
e ITSP Proxy Address: Set to the Avaya SBCE Al IP address (e.g., 10.64.91.41).
e Network Configuration - Layer 4 Protocol: Setto TLS.
e Network Configuration - Send Port: Set to 5061.
e Network Configuration > Use Network Topology Info: Set to None.
e Network Configuration - Listen Port: Set to 5061.
e Verify Calls Route via Registrar: Enabled (default)
e Click OK (not shown).

SIP Line Transport Call Details VolP  SIP Credentials SIP Advanced Engineering

ITSP Proxy Address |10.64.9141

Metwork Configuration

Layer 4 Protocol TLS ~ Send Port 3061 =
Use Network Topology Info | None w Listen Port 3061 =
Explicit DMS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar

Separate Registrar |
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5.5.4. SIP Line — Call Details tab

Select the Call Details tab. To add a new SIP URI, click the Add... button. To review an
existing SIP URI, select it and click the Edit button.

SIP Line Transport Call Details VolP  SIP Credentials SIP Advanced Engineering
SIP URIs

URl  Groups Credential Local URI Contact P Asserted ID P Preferred D Diversion Header Remote Party ID Add...

1 15 15 @ <MNeone> Aute Auto
Remove

Edit...

The SIP URI window will open. Configure the following:
e Incoming Group: Set to an unused group number, e.g., 15. This value references the
Line Group ID set on the Incoming Call Routes in Section 5.8.

e Max Sessions: In the reference configuration this was set to 10. This sets the maximum
number of simultaneous calls that can use the URI before Avaya IP Office returns busy to
any further calls.

e Outgoing Group: Set to an unused group number, e.g., 15.

e For the Local URI, and Contact fields, leave the selections under the Display and
Content columns to the default Auto.

e On the Field meaning section, set the values as shown on the screenshot below.
e Click OK.

i sip Line - 15| Call Details | SIP URI x
New URI

Incoming Group Max Sessions 10 <

Credentials 0: <None> ~

Display Content Field meaning
Outgeing Calls Forwarding/ Twinning Incoming Calls

Local URI [Auto | [Adto ] caler | |caller | |Called v
Cortact [Ato | [ato ] caler | [caler <] [Caled -
P Asserted |D [ |Mone None None None None

P Prefered ID ] Mone MNone None None None

Diversion Header [] MNone None Mane Mane None

Remote Paty ID ] Mone None None None None

oK Cancel Help

e To edit an existing entry, click an entry in the list and click the Edit button.
e When all SIP URI entries have been added or edited, click OK at the bottom of the screen
(not shown).
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5.5.5. SIP Line - VoIP tab
Select the SIP Line = VoIP tab. Set the parameters as shown below:

The Codec Selection drop-down box = System Default will list all available codecs. In
the reference configuration, Custom was selected with G729(a) 8K CS-ACELP and
G.711 ULAW 64K specified. This causes Avaya IP Office to include these codecs in the
Session Description Protocol (SDP) offer, and in the order specified. Note that in the
reference configuration G.729A is set as the preferred codec on the SIP trunk to the
AT&T IPTF network.

T.38 fax is the preferred method for fax. Set the Fax Transport Support to T.38 from
drop-down menu. G.711 fax was also tested in the reference configuration (T.38 option
disabled); however, there were limitations. See Section 2.2 for limitation with G.711 fax,
and with SG3 fax machines at the CPE.

Set the DTMF Support field to RFC2833/RFC4733. This directs IP Office to send
DTMF tones using RTP events messages as defined in RFC2833.

Set the Media Security drop-down menu to Same as System (Preferred). Verify that
the Same as System parameter is checked. This setting will use the same media security
level for the trunk as is defined for the system in Section 5.3.4. The system level media
security is set to Preferred, specifying that SRTP is preferred over RTP.

The Re-invite Supported parameter can be checked to allow for codec re-negotiation in
cases where the target of an incoming call or transfer does not support the codec
originally negotiated on the trunk.

Default values may be used for all other parameters.

Click the OK to commit (not shown).

SIP Line Transport Call Details VolP  SIP Credentials SIP Advanced Engineering

Codec Selection Custom > [ Cedec Lockdown
Unused Selected [ Allow Direct Media Path
G711 ALAW 64K ~oo | [6:729(a) 2K C5-ACELP - o
G.722 64K G.717 ULAW B4K Force direct media with phones

[ Lecal Hold Music

Re-invite Supported

[] PRACK/100rel Supported

2z

Fax Transport Support | T38 ~
DTMF Support RFC2833/RFC4733 ~
Media Security Same as System (Preferred) ~
Advanced Media Security Options Same As System
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5.5.6. SIP Line — SIP Advanced Tab

IP Office can be configured to signal when a call is placed on hold by sending an INVITE with
media attribute “sendonly”. AT&T in turn will respond with media attribute “recvonly” and will
stop sending RTP media for the duration the call is on hold. When the call is taken off of hold, IP
Office will send another INVITE with media attribute “sendrecv” indicating to AT&T to start
sending RTP again.

To have Avaya IP Office signal to AT&T when a call is placed on/off hold, select the SIP Line
- SIP Advanced tab and enter the following:

e Select Indicate HOLD in the Media section.
e Click OK to commit (not shown).

SIP Line Transport Call Details VolP  SIP Credentials 5P Advanced Engineering

Addressing Media
Association Method By Source IP address w Allow Empty INVITE |
Send Empty re-INVITE |
Allow To Tag Change |
Call Routing Method Request URI ~
P-Early-Media Support MNeone ~
Use P-Called-Party u Send SilenceSupp=0ff O
Suppress DNS SRV Lookups O
Media Connection -
. Disabled ~
) Preservation
Identity Indicate HOLD
Use "phone-context” O
Add user=phone O Call Control
Use + for International O
Use PAI for Privacy O Call Initiation Timeout (s) 4 5
Usze Domain for PA| O Call Queuing Timeout (m) 5 5
Caller ID from From header O i .
Service Busy Response 503 - Service Unavailable ~
Send From In Clear O
Cache Auth Credentials on Mo User Responding Send | 408-Request Timeout ~
User-Agent and Server Headers I:I Action on CAC Location Limit | Allow Voicemail ~
Send Location Info MNever ~ Suppress Q.850 Reason 0
Header
Add UUl header U Emulate NOTIFY for REFER O
Add UUI header to redirected mulate or
calls Mo REFER if using Diversion [
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5.6. IP Office Line

In IP Office Server Edition systems, IP Office Lines are automatically created on each server
when a Secondary server or Expansion System is added to the solution. To edit an existing IP
Office Line, select Line in the Navigation pane, and select the appropriate line to be configured
in the Group pane. The screen below shows the IP Office Line to the IP500 V2 Expansion
System.

Configuration Line = IP Office Line - Line 8
JS BOOTP (3) Line Mumber  Line Type Line SubType Line  Short Codes VolP Settings
4 Operator (3) 1 IP Office Line  WebSacket Ser|
= »g-iohﬁmnmgj -2 SIP Line Line Number g 5 Telephone Mumber l:l
ser
2% Group(7) 3 IP Office Line WebSocket Sery Transport Type WebSocket Server ~ Prefix l:l
~@X Short Code(60) -4 SIP Line
2% Directory(2) 5 IP Office Line  WebSocket Sen)| Metworking Level SCN e Qutgoing Group ID 99007
17 Time Profile(0) 6 SIP Line
; ﬁ(m;"thfu?etn ~7 P Office Line WehSacket Serd Security Medium ~ Mumber of Channels 500 =
i User Rights(1) b % IP Office Line WebSocket Seny Qutgoing Channels 500
i@ Location(7) 9oing
<52 IPOSE-Primary 10 SIP Line .
: stem (1) 15 SIP Line areway
! " 16 SIP Line Address 10 5 5 180
H Centrol Unit (3) .21 SIP Li
-y Extension (18) : 2 ap L::: Location 8: Miami - SCN Resiliency Optiens
4 User22) [ Supports Resiliency
L0 Group @ 25 SIP Line Password
8% Short Code (10) Contim 3 , [ Backs up my IP phones
X anfirm Passwor
- Service (0) [] Backs up my hunt groups
e Inceming Call Route (8
.l IP Route (3) [ Backs up my IP DECT phones

% License (10)

The screen below shows the IP Office Line, VoIP Settings tab. In the reference configuration, a
fax machine is connected to one of the analog ports on the Expansion System. Fax Transport
Support is set to T.38. Default values were used for all other parameters.

Line  Short Codes VolP Settings

Out Of Band DTMF

Allow Direct Media Path
Codec Selection Systern Default v

G.711 ALAW 64K s G.722 64K
G.711 ULAW 64K

G.729(a) 8K C5-ACELP

<4
B
Fax Transport Support T38 ~
Call Initiation Timeout (s) |4 =
Media Security Same as System (Preferred) ~
Advanced Media Security Options Same As System
MAA,; Reviewed: Solution & Interoperability Test Lab Application Notes 33 0of 84

SPOC 8/31/2019 ©2019 Avaya Inc. All Rights Reserved. IPTF_IPO11SBCES




5.7. Users, Extensions, and Hunt Groups

In this section, examples of IP Office Users, Extensions, and Groups will be illustrated. In the
interests of brevity, only one of the users and extensions shown in Figure 1 will be presented,
since the configuration can be easily extrapolated to other users. To add a User, right click on
User in the Navigation pane, and select New. To edit an existing User, select User in the
Navigation pane, and select the appropriate user to be configured in the Group pane.

5.7.1. User

The following screen shows the User tab for user 6241. As shown in Figure 1, this user
corresponds to the Avaya J169 SIP endpoint.

= j169: 6241 -3 X v <> &
Voicemail DND Short Codes  Source Mumbers  Telephony Forwarding Dial In - Voice Recording  Button Programming  Menu Programming I 4 | ¥
Name [ai169 | ~
Password |uuuouu |
Confirm Password |uuuouu |

Unique Identity

Conference PIN |uu |

Confirm Audic Conference PIN |"" |

Account Status Enabled ~
Full Narne |Avaya 1169 |
Extension [6241 |
Email Address |aj169@customera.com |
Locale ~
Priority 5 ~
System Phone Rights MNeone ~

Profile Basic User ~

[] Receptionist
Enable Softphone
Enable one-X Portal Services
Enable one-X TeleCommuter

[ Enable Remote Worker

[] Enable Desktop/Tablet VoIP client

Enable Mobile VoIP Client

Send Mobility Ernail
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5.7.2. Extension

The following screen shows the Extension information for user 6241 (Avaya J169 SIP).
To view, select Extension from the Navigation pane, and the appropriate extension from the
Group pane.

= SIP Extension: 11210 6241 ek-@ X vi<l>§
Extension  yglp

Extension ID [11210 |
Base Extension |6241 |
Phone Password |""" |
Confirm Phone Password |""" |
Caller Display Type On

Reset Volume After Calls O

Device Type Cﬁ Avaya 169 (SIP Feature)

Location Automatic ~
Fallback As Remote Worker Auto ~
Module D

Port D

Disable Speakerphone |

The following screen shows the VoIP tab for the extension. The IP Address field may be left
blank. Check the Reserve Avaya IP endpoint license box. The Codec Selection parameter may
retain the default setting “System Default” to follow the system configuration shown in Section
5.3.4. The Media Security parameter may also retain the default setting “Same as System
(Preferred)” to follow the system configuring shown in Section 5.3.4.

Extension VoIP
P Address 0 0 0 0 [ Local Hold Music
Re-invite Supported
Codec Selection System Default ™ [ Codec Lockdown
Allow Direct Media Path
G711 ALAW 64K ann G.722 64K
G.711 ULAW 64K
G.729(a) BK CS-ACELP
<<<
EES
Reserve License Reserve Avaya IP endpoint license v
Fax Transport Support | Mone v
DTMF Support RFC2833/RFC4733 v
3rd Party Auto Answer | None ~
Media Security Same as System (Preferred) ~
Advanced Media Security Options Same As System
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5.7.3. Hunt Groups
During the verification of these Application Notes, users could also receive incoming calls as
members of a hunt group. To configure a new hunt group, right-click Group from the
Navigation pane, and select New. To view or edit an existing hunt group, select Group from the
Navigation pane, and the appropriate hunt group from the Group pane.

The following screen shows the Group tab for hunt group 401. The telephone extensions in the
User List are rung based the extension that has been unused for the longest period, due to the
Ring Mode setting “Longest Waiting” (i.c., “longest waiting”, most idle user receives next

call). Click the Edit button to change the User List.

Group = Longest Waiting Group Call Center: 401 [ R R
System Name  Name Exension Group  Queuing Overflow Fallback Voicemail Voice Recording Announcements SIP
fl p MName |CEHCEﬂtEf | Profile Standard Hunt Group ~
a0 SIL Portal Extension [ao1 | O Exclude From Directory
il park 299 Ring Made LongestWaiting v No Answer Time (secs) System Default (13)
Hold Music Source No Change ~
Ring Tone Qverride [None ~|
Agent's Status on No-Answer
AgpntesT;t ions e
Central System |POSE-Primary | Advertise Group
User List
Extension Mame System
6321 ATT-Avayal140E  IPOSE-Primary
6723 Digitalé723 IP500 Expansion
6322 ATT-Avayad608  IPOSE-Primary
Edit... Remove
In the reference configuration, these steps were used to create the additional Hunt Group
“AgentGroup” (402).
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5.8. Incoming Call Route

Note — The digits defined and matched in the Incoming Call Route table, are the DNIS digits
specified in the AT&T Request-URI, not the DID digits dialed by the caller.

The Incoming Call Route table will map specific AT&T DNIS numbers to an IP Office User, or
Hunt Group, as well as to VVoicemail Pro scripts.

To add an incoming call route, right click on Incoming Call Route in the Navigation pane and
select New (not shown). To edit an existing incoming call route, select an Incoming Call Route
in the Navigation pane, and the associated call route information is displayed in the Group pane.

5.8.1. Calls to IP Office Stations and Hunt Groups

In the example below, the incoming number 0000011041 is directed to H.323 phone 6322.

On the Standard tab enter the following:
e Line Group ID: Enter the SIP Line defined in Section 5.5 (e.g., 15).
e Incoming Number: Enter the associated DNIS digits sent by AT&T (e.g., 0000011041).
e Use default values for the remaining fields and click OK (not shown).

Standard  Voice Recording Destinations

Bearer Capability Any Voice ~
Line Group 1D |15 v
Inceming Mumber |DDDDD11D41

Inceming Sub Address |

Inceming CLI |

Locale ~
Pricrity 1-Low ~
Tag | |
Hold Music Source Systern Source ~
Ring Tone Override |Nor1e V|

Select the Destinations tab. From the Destination drop-down menu, select the endpoint
associated with this DID number. In the reference configuration, AT&T DNIS number
0000011041 was associated with the Avaya IP Office user at extension 6322.

Standard Voice Recording Destinations

TimeProfile Destination Fallback Extension

4 Default Value 6322 ATT-Avaya9608 ~ ~
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Below is an example of a call for AT&T DNIS 0000051045 being directed to Hunt Group 401

(Call Center).

Bearer Capability

Line Group ID
Inceming Mumber
Inceming Sub Address
Incarming CLI

Locale

Pricrity

Tag

Hold Music Source

Ring Tone Override

Standard  Voice Recording Destinations

Any Voice

|15

|0000051045

1-Low

System Source

|Nu:|r|e

Standard Voice Recording Destinations

TimeProfile

3 Default Value

Destination

401 Call Center

Fallback Extension
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5.8.2. Calls to Voicemail Pro Scripts

As described next in Section 5.9, Voicemail Pro scripts are defined with specific names. These
script names are specified as destinations in the Incoming Call Route table.
In the example below, incoming number 0000021042 is directed to the Voicemail Pro Auto-

Attendant script ATT_IPTF.

1. On the Standard tab repeat the steps in Section 5.8.1, with the following changes:
e Incoming Number: Enter the associated DNIS digits sent by AT&T (e.g., 0000021042).
2. On the Destinations tab enter the following:
e In the Destinations column, enter the string VM:ATT_IPTF from the drop down menu
(note if the voicemail module does not appear in the list, enter the value manually).

e Use default values for the remaining fields and click OK (not shown).

Bearer Capability

Line Group ID
Incaming Mumber
Inceming Sub Address
Inceming CLI

Locale

Pricrity

Tag

Hold Music Source

Standard  Voice Recording  Destinations

Any Voice

|15r

|DDDDDE1 042

1- Low

Systern Source

Ring Tone Override |None v|
Standard Voice Recording  Destinations
TimeProfile Destination Fallback Extension
3 Default Value VM:ATT_IPTF v
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5.9. Call Center Provisioning in Voicemail Pro

Note — While Voicemail Pro provisioning and programming is beyond the scope of this

document, a sample Auto-Attendant script is described below.

In the reference configuration, VVoicemail Pro is used for VVoicemail processing as well as for
simulating basic Call Center functionality.

The Auto-Attendant function was provisioned to prompt callers to select a numeric option (1, 2,
or 3), that would transfer the call to an associated Avaya IP Office Hunt Group (Call Center,
AgentGroup), or to a specific extension. This is accomplished via the following steps:

1. Hunt Groups Call Center and AgentGroup are created in IP Office (Section 5.7.3).

2. User 6241 is created in IP Office (Section 5.7.1)

3. Incoming Call Route for DNIS digits 0000021042 is defined for access to the Auto-
Attendant script (Section 5.8.2).

4. Viathe Voicemail Pro GUI interface:

e Open the Voicemail Pro Client application and log in to the VVoicemail Pro server

(not shown).

e Create a Start Point by right clicking on Modules and selecting Add.

H& L 2@

\[j Voicemail Pro Client (Intuity) - Connected

File Edit Actions Administration

+ {j Server Queues
-t} Distributed Voicemails
6 Eventing Notifications

-2 IPOSE-Primary (10.64.19.170)
: Cj Voicemail Pro Administrators

j Delete

"ﬁ Rename

e Enter aname (e.g., ATT_IPTF) and click on OK (not shown). The new script
“ATT _IPTF” will appear under Modules and a Start Point icon will appear in the work

area.
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T:I Voicemail Pro Client (Intuity) - Connected to 10.64.19.170 (Select Mode)
File Edit Actions Administration Help

A& 4 2@ 2% H- S8 /HF-E-B- & [-08-%

-2} IPOSE-Primary (10.64.19.170) Wodies > ATTAPTE
{: Voicemail Pro Administrators o
& G Server Queues
i O Distributed Voicemails
E cj Eventing Notffications > Start Point
Next
= E‘ Modules
=EE ATT_AA
=2 ATT_IPTC
=2 ATT_IPTF
P Start Pairt
e Click on the Start Point icon —_=_ {0 activate the script options at the top of the

‘) CEE
screen. From the options, select the Basic Actions icon ﬂ& select the Menu icon BEg,

and click on the work area to place the Menu icon.
i. Double click the Start Point icon.
1. Onthe General tab - Token Name, enter Start Point and click OK
(not shown).
ii. Double click the Menu icon.
1. Onthe General tab - Token Name, enter Menu (not shown).
2. Onthe Entry Prompts tab (not shown), select or create an Entry
Prompt that will tell the caller what digits to press (e.g.,
mainmenu.wav). To modify an existing recording, double click on the

.wav file and rerecord. If no .wav files exist, double click on the ER
icon to open the .wav editor.
3. On the Touch Tone tab:
a. Select 1, 2, and 3 as the possible entry digits.
b. Select 3 for No of Retries.
4. Click on OK.
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Properties for Menu *
General Ertry Prompts  Touch Tones  Reporting  Results

sr
x

1
2
3
4
5
6
8
9
0
#
al

wvalid Input Handling
31| Mo of Retries Prompt

w5 OOO0000OO0ORIEIE

Timeout 5 2! seconds
[ Invalid Entry

Gl Heb

e Click on the Telephony Actions iconﬁ , select the Transfer icon ™ | and click on the
work area to place the Transfer icon in the work area. This will be used for “Call
Center”. Select and place two more Transfer Icons (these will be used for “AgentGroup”
and “User 6241”).

i. Double click on the first Transfer icon.
1. Onthe General tab > Token Name = Transfer to 401 - Call Center
(not shown).
2. On the Specific tab - Destination = 401 (not shown).
ii. Double click on the second Transfer icon.
1. Onthe General tab > Token Name = Transfer to 402 -
AgentGroup (not shown).
2. On the Specific tab - Destination = 402 (not shown).
iii. Double Click on the third Transfer icon.
1. Onthe General tab, Token Name = Transfer to 6241 (not shown).
2. On the Specific tab, Destination = 6241 (not shown).

e From the options bar, select the Connector icon < and:
i. Drag a connecting flow line from the Start Point box to the Menu box (see
screen shot below).
ii. Drag connecting flow lines from each of the Menu options to their associated
Transfer boxes (see screenshot below).
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T:I Voicemail Pro Client (Intuity) - Connected to 10.64.19.170 (Select Mode)
File Edit Actions Administration Help

A@ L 2B 200 4 Sa¥ 2 QT &8 L ek

& [j IPOSE-Primary (10.64.13.170)
{j Voicemail Pro Administrators

& C: Server Queues

O Distributed Voicemails

¢ cj Eventing Notffications ' Start Point

Next
% Transfer to 401 -Call Center |
oEE M
Sm e

Modules > ATT_IPTF

T
f Transfer to 402 - AgentG
2 5B 1ansfer to AgentGroup I
3
-8 Modules :
=2 ATT_AA 4 Transfer to 6241
-.=8& ATT_IPTC
=& ATT_IPTF

5. From the top menu select File > Save & Make Live or select the & icon.

When the associated AT&T DNIS number is received (e.g., 0000021042), IP Office will send
the call to Voicemail Pro. The caller will be prompted to enter 1, 2, or 3 to access Call Center,
AgentGroup, or user 6241. The associated Avaya IP Office extension (e.g., 401, 402, or 6241)
will then ring.
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5.10. Save IP Office Primary Server Configuration

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP
Office server in order for the changes to take effect. At the top of the Avaya IP Office Manager
page, click File = Save Configuration (if that option is grayed out, no changes are pending).

A screen similar to the one below will appear, with either Merge or Immediate automatically
selected, based on the nature of the configuration changes. The Merge option will save the
configuration change with no impact to the current system operation. The Immediate option will
save the configuration and cause the Avaya IP Office server to reboot.

Click OK to execute the save.

T Send Multiple Configurations — O X
Select ) Change . Incoming Outgoing Error
I Office Maode RebootTime Call Barring Call Barring Status Progress
b IPOSE-Primary | Merge « | 10:02 AM O O Q
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6. Avaya IP Office Expansion System Configuration

Navigate to File > Open Configuration (not shown), select the proper Avaya IP Office system

from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign
next to IP500 Expansion on the left navigation pane will expand the menu on this server.

Configuration |

-
i

System Inventory

=& BOOTP (3)
-

Operator (3)
¥ Solution
G-f User (49)
(-3 Group(T)
8% Short Code(80)
[#-=& Directory(2)
£ Tirne Profile(0)
-l Account Code(1)
@4 User Rights(1)
-8 Location(7)
-3 IPOSE-Primary
IPOSE-Seconda
=7 System (1)
-4 Line (8)
= Control Unit (4)
-4 Extension (17)
-f User(4)
:ﬂ Group (0)
-8 Short Code (2)
- Service (0)
[H-alf; RAS (1)
e Inceming Call Route (0}
S WAN Port (0)
- Firewall Profile (1)
-l 1P Route (2)
- License (2)
-l Tunnel (0}
- ARS (3)
&5 Location (7)
ﬂ Authorization Code (0)

-

-

Server Edition Expansion System

= Hardware Installed

Control Unit: IP 500 V2
Internal Modules: VCME4/PRID U, PHOMES; COMBOG210/ATM4
Expansion Modules: MOMNE

= System Settings

IP Address: 10.5.5
Sub-Met Mask
Default Gatewa 5
System Locale: United States (US English)
System Location: 8: Miami

Device ID: NONE

Number of Extensions on System: 17

= Features Configured

Licenses Installed: Avaya IP endpoints(1); Server Edition{1); IP Office Select{1)
Connected Extensions: 6723

Users NOT Configured for Voicemail: Analog&727

Users assigned as Ex-Directory: MOME

Users assigned for Twinning: NONE

Users barred from making Cutgoing Calls: NONE

Music on Hold: External

6.1. Expansion System - Physical Hardware

In the sample configuration, the IP500 V2 Expansion System contained a PHONES analog card

and a COMBO6210 card, for the support of analog and digital stations. Also included is a
VCM®64 (Voice Compression Module). Both the VCM64 and the COMBO6210 cards provide
voice compression channels to the control unit. VVoice compression channels are needed to
support VolP calls, including IP extensions and or IP trunks.

SPOC 8/31/2019

Configuration | Control Unit = IP 500 V2
R BOOTP (3 Dev Mo, Dev Type Version Unit
Operator (3) “ IP 500 V2 11.0.4.0.0 build 74 Device Numb |1 |

__;”'”JL”E’:(@] “2  VCMBY/PRDU  11.04.0.0 build 74 svice Number

_____ ¢ Group() “23  PHONEB 11.0.4.0.0 build 74 Unit Type [P 500v2 |
..... 8X Short Code(60) “d COMBOB210/ATMA  11.0.4.0.0 build 74 _ -

_____ 2= Directon(?) Version |11.o.4.o.o build 74 |
£ Time Profile(0)

i 00eD0706ebf2

----- 8 Account Code(1) serial Number | i |

----- §5 UserRights(1) )
Unit IP Add 10.5.5.180

""" & Location(7) n ress | |
&= POSE-Primary Interconnect Mumber |O |
[#-%53 |POSE-Secondary
(=57 IP500 Expansion Module Number |C0ntr0| Unit |

7 System (1)
7 Line (8)
el Control Unit (4)
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6.2. Expansion System - LAN Settings

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise
network. To view or configure the LAN1 IP address, select System on the Navigation pane.
Select the LAN1 - LAN Settings tab on the Details pane, and enter the following:

e IP Address: 10.5.5.180 was used in the reference configuration.

e IP Mask: 255.255.255.0 was used in the reference configuration

e Click the OK button (not shown).

IP500 Expansion

System LAM1  |ANZ DNS  Voicemail Telephony Directory Services Systemn Events SMTP  SMDR  VCM
LAMN Settings  ViolP Metwork Topology

IP Address 10 5 5 180

IP Mask 235 255 255 0

Primary Trans, IP Address 0 0 0 0

RIP Mode Mone -
[] Enable NAT

Murnber Of DHCP IP Addresses 200 |5
DHCP Mode
() Server () Client () Dialln (@ Disabled Advanced

Defaults were used on the VoIP and Network Topology tabs (not shown).

6.3. Expansion System - IP Route
To create an IP route for the Expansion system, right-click on IP Route on the left Navigation
pane. Select New (not shown).

e Enter 0.0.0.0 on the IP Address and IP Mask fields to make this the default route.

e Set Gateway IP Address to the IP Address of the default router in the IP Office subnet.
The default gateway in the reference configuration was 10.5.5.2

e Set Destination to LAN1 from the pull-down menu.

= 0.0.0.0 &F-E X[ v
IP Route
IP Address 0 0 0 0
IP Mask 0 0 0 0
Gateway IP Address 10 5 5 2
Destination LAMNT ~
Metric 1 =
[ Proxy ARP
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6.4. Expansion System - IP Office Line

The IP Office Line was automatically created on each server when the Expansion System is
added to the solution. Below is the IP Office Line to the Primary server.

IP Office Line - Line 17

Line  Short Codes VolP Settings T38 Fax

Line Mumber 7 S
Transport Type WebSocket Client
Metworking Level SCN

Security Mediurm

Gateway

Address 10 64 19 170
Location 2: Denver

Password

Confirm Password

Telephone Number

~ Outgeing Group 1D 99999
~ MNumber of Channels 250 =
Outgeing Channels 250 =
Port 443 L

“ SCN Resiliency Options
[] Supports Resiliency
[ Backs up my IP phones
[ Backs up my hunt groups
[ Backs up my IP DECT phones

Description

In the reference configuration, a fax machine is connected to one of the analog ports on the

Expansion System. To accommodate T.38 fax, select the VolP Settings tab and set Fax

Transport Support to T38.

¥

IP Office Line - Line 17

Line  Short Codes VolP Settings T38 Fax

Codec Selection Custom

Unused

G.711 ALAW 64K e
(G.723.1 6K3 MP-MLQ

R

Fax Transport Support T38

-

Call Initiation Timeout (s) |4 =
Media Security Same as System (Preferred)

Advanced Media Security Options

[ VolP Silence Suppression
Out Of Band DTMF

Allow Direct Media Path
Selected
G.722 84K
(G.729(a) 8K CS-ACELP
G711 ULAW 84K

Same As System
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Select the T38 Fax tab. The Use Default Values box is unchecked, and the T38 Fax Version is

set to “0”. All other values are left at default.

IP Office Line - Line 17

Line  Short Codes VolIP Settings 138 Fax
T38 Fax Version o w
Scan Line Fi-up
Transport UDPTL
TFOP Enhancement
Redundancy
[] Disable T30 ECM
Low Speed 0 o . .
[[] Disable EFlags For First DIS
. 0 -
High Speed = [] Disable T30 MR Compression
TCF Method Trans TCF ~ [] NSF Override
Max Bit Rate (bps) 14400 v 0
EFlag Start Timer (msecs) 2600 o E
EFlag Stop Timer (msecs)  [2300 S
Tx Metwork Timeout (secs) 130 =
[] Use Default Values

6.5. Save IP Office Expansion System Configuration
Navigate to File = Save Configuration in the menu bar at the top of the screen to save the

configuration performed in the preceding sections

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service

disruption. Click OK to proceed.

'™ Send Multiple Configurations - O X
o Posice Mode RebootTime (VT Cibammg  Swes PO
3 IP500 Expansion  |Merge v 1212 PM O 0 Q |
Cancel Help
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7. Configure Avaya Session Border Controller for Enterprise
This section covers the configuration of the Avaya SBCE. It is assumed that the initial
provisioning of the Avaya SBCE, including the assignment of the management interface 1P
Address and license installation have already been completed; hence these tasks are not covered
in these Application Notes. For more information on the installation and provisioning of the
Avaya SBCE consult the Avaya SBCE documentation in the Additional References section.

Use a WEB browser to access the Element Management Server (EMS) web interface, and enter
https://ipaddress/sbc in the address field of the web browser, where ipaddress is the management
LAN IP address of the Avaya SBCE.

Enter the Username and click on Continue.

AVAYA =

Continue

WELCOME TO AVAYA SBC

Unauthorized access fo this machine is prehibited. This system is for

SESS|0n Border ContrOI Ier the use authorized users enly. Usage of this system may be monitored
.I.'or El'lte rp I'ise and recorded by system perscnnel.

Anyone using this system expressly consenis fo such monitering and
iz advized that if such menitoring reveals possible evidence of criminal
activity, system personnel may provide the evidence from such
menitering to law enfercement officials.

@ 2011 - 2019 Avaya Inc. All rights reserved.

Enter the password and click on Log In.

Q v o Q Log In
Username: ucsec

Password:
Log In
Session Border Controller WELCOMETO Avava s8C
for Enterprise Unauthorized access to this machine is prehibited. This system is for

the use authorized users only. Usage of this system may be monitored
and recerded by system personnel.

Anyene using this system expressly consenis fo such monitoring and
is advised that if such monitering reveals possible evidence of criminal
acfivity, system personnel may provide the evidence from such
menitering to law enforcement officials.

22011 - 2019 Avaya Inc. All rights reserved.
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The EMS Dashboard page of the Avaya SBCE will appear. Note that the installed software
version is displayed. Verify that the License State is OK. The SBCE will only operate for a
short time without a valid license. Contact your Avaya representative to obtain a license.

Device: EMSv  Alarms  Incidents Statusv  Logsv  Diagnostics  Users Settings v Help ¥ Log Out
Session Border Controller for Enterprise AVAYA
EMS Dashboard Dashboard
> System Administration

System Time 08:42:44 AM MDT Refresh EMS
Backup/Restore
. Monitoring & Logging Version 8.0.0.0-19-16991 SBCES-T0

Euild Date Sat Jan 26 21:58:11 UTC 2019

License State @ OK

Aggregate Licensing Overages 0

Peak Licensing Overage Count 0

Last Logged in at 07/22/2019 08:32:03 MDT
Failed Login Attempts 0
Active Alarms (past 24 hours) Incidents (past 24 hours)
None found SBCEB-70: No Subscriber Flow Matched
Add

No notes found

7.1. Device Management — Status

Select Device Management on the left-hand menu. A list of installed devices is shown on the
Devices tab on the right pane. In the case of the sample configuration, a single device named
SBCES8-70 is shown. Verify that the Status column shows Commissioned. If not, contact your
Avaya representative. To view the configuration of this device, click View on the screen below.

Note — Certain Avaya SBCE configuration changes require that the underlying
application be restarted. To do so, click on Restart Application shown below.

Device: EMSv  Alamms  Incidents Statusv Logsv  Diagnostics Users Settings v Help ¥ Log Out
Session Border Controller for Enterprise AVAYA
EMS Dashboard Device Management

Device Management

> System Administration

Backup/Restore Devices H Updates || SSL VPN || Licensing H Key Bundles ‘
» Monitoring & Logging Device Name Management IP Version Status
8.0.0.0-
SBCES-70 10.64.90.70 19- Commissioned Reboot Shutdown Restart Application View Edit Uninsta
16991
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The System Information screen shows the Network Configuration, DNS Configuration and
Management IP(s) information provided during installation and corresponds to Figure 1. In the
shared test environment, the highlighted Al and B1 IP addresses are the ones relevant to the
configuration of the SIP trunk to AT&T.

System Information: SBCES-T0 X

General Configuration Device Configuration ———————————— - Dynamic License Allocation ———
Appliance Name ~ SBCES-70 HA Mode Mo Min Max
License License

Box Type sIP Two Bypass Mode No Allocation  Allocation
Deployment Mode  Proxy Standard Sessions 10 100

Advanced Sessions 10 100

Scopia Video Sessions 10 100

CES Sessions 10 100

Transcoding Sessions 10 100

CLID -

Encryption 7

Available: Yes

r Network Configuration
1P Public IP MNetwork Prefix or Subnet Mask  Gateway Interface
10.64.91.40 10.64.91.40 255.255.255.0 10.64.911 Al
10.64.91.41 10.64.91.41 2552552550 10.64.911 Al
192.168.80.43 192.168.80.43 255 255 255 128 192.168.80.1 B1
B1
B1
B2
r DNS Cenfiguration Management IP(s)
Primary DNS 10.64.19.201 IP #1 (IPvd) 10.64.90.70
Secondary DNS
DMS Location DMz
DNS Client IP 10.64.91.40
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7.2. TLS Management

Note — Testing was done using identity certificates signed by a local certificate authority. The
procedure to create and obtain these certificates is outside the scope of these Application Notes.

In the reference configuration, TLS transport is used for the communication between IP Office
and Avaya SBCE. The following procedures show how to view the certificates and configure the
profiles to support the TLS connection.

7.2.1. Verify TLS Certificates — Avaya Session Border Controller for
Enterprise
To access the SBCE configuration menus, select the SBCE device from the top navigation menu.

Device: EMSv  Alarms Incidents Statusv  Logsv  Diagnostics  Users Settings v Help ¥ Log Out

EMS

SBCES70 er Controller for Enterprise AVAYA

Select TLS Management - Certificates from the left-hand menu. Verify the following:
e The root CA certificate is present in the Installed CA Certificates area.
e The signed identity certificate is present in the Installed Certificates area.
e The private key associated with the identity certificate is present in the Installed Keys

area.
Device: SBCE8-70v Alarms  Incidents  Statusv Logsv Diagnostics  Users Seftingsv¥  Help ¥ Log Out
Session Border Controller for Enterprise AVAYA
EMS Dashboard Certificates
Device Management Install | [Generate GSR

| =enemte Lok |
Backup/Restore

> System Parameters Certificates

» Configuration Profiles [ ——

> Services sbee8_70.pem View Delete

» Domain Policies

4 TLS Management Installed CA Certificates
Certificates SystemManagerCA pem View Delete
Client Profiles
Server Profiles Installed Certificate Revocation Lists

SNI Group No certificate revocation lists have been installed
> Network & Flows
> DMZ Services
> Monitoring & Logging

Installed Ceriificate Signing Requests

No certificate signing requests have been installed

Installed Keys

shee70 key Delete
shceb_70 key Delete
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7.2.2. Server Profiles
Step 1 - Select TLS Management - Server Profiles and click on Add. Enter the following:

e Profile Name: enter descriptive name.

e Certificate: select the identity certificate, e.g., sbce8 70.pem, from pull down menu.
e Peer Verification = None.

e Click Next.

Step 2 - Accept default values for the next screen (not shown) and click Finish.

Edit Profile X

WARNING: Due to the way OpenSSL handles cipher checking, Cipher Suite validation will

pass even if one or more of the ciphers are invalid as long as at least one cipher is valid. Make
sure to carefully check your entry as invalid or incomectly entered Cipher Suite custom values
may cause catastrophic problems.

TLS Profile
Profile Name shced_T0Server
Certificate shced_70.pem v
SNI Options Mone v
SNI Group None v

Certificate Verification

Peer Verification Mona v

SystemManagerCA pem a

Peer Certificate Authorities

Peer Certificate Revocation Lists

Verification Depth 0

Next
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The following screen shows the completed TLS Server Profile form:

Session Border Controller for Enterprise AVAYA

EMS Dashboard
Device Management

Server Profiles: sbce8_70Server

Add
Server Profiles

shced_70Server

o
s
e
w

Backup/Restore

> System Parameters Click here to add a description.

> Configuration Profiles Server Profile

H

Services
TLS Profile

Damain Policies

4 TLS Management Profile Name sbced_T0Server
Certificates Certificate sbce8_70 pem
Client Profiles SNI Options None
Server Profiles

> Network & Flows Peer Verification None

> DMZ Services

Extended Hostname Verification

Monitoring & Logging

Renegotiation Parameters
Renegotiation Time 0

Renegotiation Byte Count 0

Handshake Options

Version 4 TS 1.2 TLS 11 TS 1.0
Ciphers Default FIPS Custom
Value HIGH:IDH:IADH:IMD5:laNULL:leNULL-@STRENGTH
Edit
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7.2.3. Client Profiles
Step 1 - Select TLS Management - Client Profiles and click on Add. Enter the following:

Profile Name: enter descriptive name.

Certificate: select the identity certificate, e.g., sbce8 70.pem, from pull down menu.
Peer Verification = Required.

Peer Certificate Authorities: select the CA certificate used to verify the certificate
received from Session Manager, e.g., SystemManagerCA.pem.

Verification Depth: enter 1.

Click Next.

Step 2 - Accept default values for the next screen (not shown) and click Finish.

Edit Profile X

WARNING: Due to the way OpenSSL handles cipher checking, Cipher Suite validation will

pass even if one or more of the ciphers are invalid as long as at least one cipher is valid. Make
sure to carefully check your entry as invalid or incomectly entered Cipher Suite custom values
may cause catastrophic problems.

TLS Profile
Profile Name shced_TO0Client
Certificate shced 70 pem b
SNI Enabled
Peer Verification Required
SystemManagerCA pem

Peer Certificate Authorities

Peer Certificate Revocation Lists

Verification Depth 1
Extended Hostname Verification

Server Hostname

Mext
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The following screen shows the completed TLS Client Profile form:

Session Border Controller for Enterprise AVAYA

EMS Dashboard Client Profiles: shce8 70Client
Device Management Add
Backup/Restore
Client Profiles Click here to add a description.
» System Parameters
» Configuration Profiles sbeed_T0Client Client Profile

el
ke
o
@

> Services
. Domain Polces
4 TLS Management Profile Name sbceB_70Client

Certificates Certificate sheeB 70.pem

Client Profiles

SNI Enablad
Server Profiles
SNI Group Certificate Verification
> Network & Flows Pser Varification Required
> DMZ Services
Peer Certificate Authorities SystemManagerCA pem

Monitoring & Logging
Peer Certificate Revocation Lists —

Verification Depth 1

Extended Hostname Verification

Renegotiation Parameters

Renegotiation Time 0
Renegotiation Byte Count 0
Version 4 TLs1.2 TS 11 TS 1.0
Ciphers Default FIPS Custom
Value HIGH:IDHIADH:IMD5 laNULL leNULL- @STRENGTH
Edit
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7.3. Network Management

The Network Management screen is where the network interface settings are configured and
enabled. During the installation process of Avaya SBCE, certain network-specific information is
defined such as device IP address(es), public IP address(es), netmask, gateway, etc., to interface
the device to the network. It is this information that populates the various Network Management
tab displays, which can be edited as needed to optimize device performance and network
efficiency. Navigate to Networks & Flows - Network Management. On the Networks tab,
verify the IP addresses assigned to the interfaces. The following screen shows the enterprise
interface is assigned to Al and the interface towards AT&T is assigned to B1.

The following Avaya SBCE IP addresses and associated interfaces were used in the sample
configuration:

e Al:10.64.91.41 — IP address configured for AT&T IPTF to IP Office.
e B1:192.168.80.43 — IP address configured for the AT&T IPTF service. This address is
known to AT&T. See Section 3.

Session Border Controller for Enterprise AVAYA
EMS Dashboard Network Management
Device Management
Backup/Restore
> System Parameters Interfaces | | Networks
> Configuration Profiles Add
> Services
Name Gateway Subnet Mask / Prefix Length Interface IP Address
> Domain Policies
Inside-A1 1064911 255 2552550 Al 10.64.91.40, 10.64.91.41 Edit Delete
> TLS Management
4 Network & Flows Outside-B1 192.168.80.1 255.255.255.128 B1 192.168.80.43 Edit
Network Outside-B1-IPv6 64 B1
Management
Media Interface Outside-B2 255255255248 B2

Signaling Interface

End Point Flows

Verify that the interfaces are enabled on the Interfaces tab. The following screen shows
interfaces Al and B1 with status Enabled. To enable an interface, click the corresponding
Disabled link under the Status column to change it to Enabled.

Session Border Controller for Enterprise AVAYA
EMS Dashboard Network Management
Device Management
Backup/Restore
» System Parameters Interfaces | | Networks
> Configuration Profiles Add VLAN
> Services
Interface Name VLAN Tag Status.
> Domain Palicies "
> TLS Management Al Enabled
4 Network & Flows — Dtz
Network B1 Enabled
Management B2 Enabled
Media Interface
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7.4. Media Interfaces

Media Interfaces are created to specify the IP address and port range in which the Avaya SBCE
will accept media streams on each interface. Packets leaving the interfaces of the Avaya SBCE
will advertise this IP address, and one of the ports in this range as the listening IP address and
port in which the SBCE will accept media from the connected server.

To create a new Media Interface in the enterprise direction, navigate to Network & Flows -
Media Interface on the left-hand side menu, and click Add (not shown). On the Add Media
Interface screen, enter an appropriate Name for the Media Interface. Select the Avaya SBCE
private IP Address from the IP Address drop-down menu. Note that the Port Range was
configured with the values required by AT&T (16384 — 32767). Click Finish.

Some ports in the range required by AT&T were already allocated by the Avaya SBCE for
internal use, by default. See Section 7.14 for the steps required to reallocate the port ranges used
by the Avaya SBCE, so the range required by AT&T could be accommodated.

The screen below shows the Inside-Media-TollFree media interface created in the reference
configuration.

Edit Media Interface X

MName Inside-Media-TollFree
Inside-A1 (A1, VLAN 0) v
IP Address
10649141 v
Port Range 16384 - 32767
Finish

A second Media Interface towards the AT&T network was similarly created with the name
Outside-Media, as shown below. The outside IP Address of the Avaya SBCE on the B1
interface was selected from the drop-down menu. The Port Range was configured with the
values required by AT&T (16384 — 32767).

Edit Media Interface X

Namea Outside-Media
Outside-B1 (B1, VLAN 0) v
IP Address
192.168.80.43
Port Range 16384 - 32767
Finish
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7.5. Signaling Interfaces

The Signaling Interface screen is where the SIP signaling ports are defined. Avaya SBCE will
listen for SIP requests on the defined ports. Create a signaling interface for the inside and outside

IP interfaces.

To create a new Signaling Interface on the enterprise direction, navigate to Network & Flows -
Signaling Interface and click Add. On the Add Signaling Interface screen, enter an
appropriate Name for the interface. Select the private IP Address for the Avaya SBCE from the
IP Address drop-down menu. Since TLS is used in the sample configuration to listen for
signaling traffic from the IP Office, 5061 is entered under TLS Port. The TLS Profile is set to
the TLS server profile sbce8_70Server shown on Section 7.2.2. Click Finish.

Edit Signaling Interface X

Name

IP Address

TCP Port

Leave blank to disable

UDP Port

Leave blank to disable
TLS Port
Leave blank to disable
TLS Profile
Enable Shared Control

Shared Control Port

Inside-Sig-TollFree-41

Inside-A1 (A1, VLAN 0) M
10649141 v

5061

sbced_70Server ¥

Finish

A second Signaling Interface with the name Outside-Signaling was similarly created in the
network direction. The B1 interface IP Address of the Avaya SBCE was selected from the drop-
down menu. Under UDP Port, enter 5060 as specified by AT&T. Click Finish.

Edit Signaling Interface X

Name

IP Address
TCP Port
Leave blank to disable

UDP Port

Leave blank to disable
TLS Port
Leave blank to disable
TLS Profile

Enable Shared Control

Shared Control Port

Outside-Signaling

Outside-B1 (B1, VLAN 0) v
192.168.80.43 ¥

5060

None

Finish
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7.6. Server Interworking Profile

The Server Internetworking profile includes parameters to make the Avaya SBCE function in an
enterprise VoIP network using different implementations of the SIP protocol. There are default
profiles available that may be used as is, or modified, or new profiles can be configured as
described below.

In the sample configuration, separate Server Interworking Profiles were created for IP Office and
AT&T IPTF service.

7.6.1. Server Interworking Profile — IP Office

In the sample configuration, the IP Office Server Interworking profile was cloned from the
default avaya-ru profile. To clone a Server Interworking Profile for IP Office, navigate to
Configuration Profiles = Server Interworking, select the avayu-ru profile and click the
Clone button. Enter a Clone Name and click Finish to continue.

Clone Profile
Profile Name avaya-ru

Clone Name Enterprise Interwork

Finish

The following screen shows the Enterprise Interwork profile used in the sample configuration,
with T.38 Support set to Yes. To modify the profile, scroll down to the bottom of the screen and
click Edit. Select the T.38 Support parameter and then click Next and then Finish (not shown).
Default values can be used for all other fields.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Interworking Profiles: Enterprise Interwork

Device Management

Backup/Restore

> System Parameters

4 Configuration Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups
Reverse Proxy Policy

> Services

> Domain Policies

» TLS Management

> Network & Flows

> DMZ Services

> Monitoring & Logging

Add

Interworking Profiles

cs2100
avaya-ru
Enterprise Interwork

ATT-Interworking

Click here to add a description.

General H Timers H Privacy H URI

i HHeader ipulati H

Rename || Clone || Delete

General

Hold Support
180 Handling
181 Handling
182 Handling
183 Handling
Refer Handling
URI Group
Send Hold
Delayed Offer
3xx Handling
Diversion Header Support
Delayed SDP Handling
Re-Invite Handling
Prack Handling
Allow 18X SDP

NONE
None
None
None
None
No
None
No
Yes
No
No
No
No
No
No

T:38 Support

Yes

URI Scheme

Via Header Format

SIP
RFC3261

Edit
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7.6.2. Server Interworking Profile — AT&T

To create a new Server Interworking Profile for AT&T, navigate to Configuration Profiles >
Server Interworking and click Add as shown below. Enter a Profile Name and click Next.

Interworking Profile

Profile Name ATT-Interworking

Next

The following screens show the ATT-Interworking profile used in the sample configuration.
On the General tab, default values are used with the exception of T.38 Support set to Yes.

Session Border Controller for Enterprise AVAYA
EMS Dashboard Interworking Profiles: ATT-Interworking
Device Management Add Rename || Clone || Delete
Backup/Restore
Interworking Profiles Click here to add a description._
> System Parameters
2100
+ Gonfiguration Profiles < General || Timers || Privacy | | URI Manipulation || Header Manipulation || Advanced |
Domain DoS avaya-ru
Server Interworking —————
Media Forking X Hold Support NONE
ATT.Interworking
Routing 180 Handling None
Tapology Hiding 181 Handiing Nane
Signaling Manipulation
9 9 P 182 Handling None
URI Groups
SNIMP Traps 183 Handling None
Time of Day Rules Refer Handling No
FGDN Groups URI Group Nane
Reverse Proxy Policy Send Hold No
> Services
Delayed Offer Yes
> Domain Policies
> TLS Management F=HET I e
> Network & Flows Diversion Header Support No
» DMZ Services Delayed SDP Handling No
» Monitoring & Logging Re-Invite Handling No
Prack Handling No
Allow 18X SDP No
T 38 Support Yes
URI Scheme SiP
Via Header Format RFC3261

Edit
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The Timers tab shows the values used for compliance testing for the Trans Expire field. The
Trans Expire timer sets the allotted time the Avaya SBCE will try the first primary server
before trying the secondary server, if one exists.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Interworking Profiles: ATT-Interworking

Device Management

Backup/Restore

> System Parameters

4 Configuration Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups

Add

Rename || Clone || Delete

Interworking Profiles Click here fo add a description.

cs2100
avaya-ru
Enterprise Interwork

ATT-Interworking

Ad "

General H Timers H Privacy H URI i H Header

Min-SE -
Init Timer -
Max Timer -
Trans Expire 4 seconds

Invite Expire —

Edit

Click Next to accept default parameters for the Privacy, URI Manipulation, and Header
Manipulation tabs (not shown) and advance to the Advanced area. Record Routes is set to
Both Sides. Default values can be used for all other fields.

Session Border Controller for Enterprise

EMS Dashboard
Device Management
Backup/Restore

> System Parameters

4 Configuration Profiles es2100 General H Timers H Privacy H URI Manipulati || Header Advanced
Domain DoS avaya-ru
Server Interworking B s Record Routes. Both Sides
Media Forking ATTInterworking Include End Point IP for Context Lookup No
Routing Extensions None
Topology Hiding Diversion Manipulation No
Signaling Manipulation
URI Groups Has Remate SBC Yes
SNMP Traps Route Response on Via Port No
Time of Day Rules Relay INVITE Replace for SIFREC No
FGDN Groups MOBX Re-INVITE Handling No
Reverse Proxy Policy
> Domain Policies DTMF Support None
> TLS Management .
> Network & Flows LEdt)

AVAYA

Interworking Profiles: ATT-Interworking

Add

Rename || Clone || Delete

Interworking Profiles Click here fo add a description.
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7.7. SIP Servers Profiles

The SIP Server Profile contains parameters to configure and manage various SIP call server-
specific parameters such as TCP and UDP port assignments, heartbeat signaling parameters, DoS
security statistics, and trusted domains.

In the sample configuration, separate Server Configurations profiles were created for the IP
Office and the AT&T IPTF service.

7.7.1. SIP Server Profile — IP Office

To add a SIP Server Profile for IP Office, navigate to Services = SIP Servers and click Add.
Enter a descriptive name for the new profile and click Next.

Add Server Configuration Profile X

Profile Name IPOSE-Call-Server

Next

The following screens illustrate the SIP Server Profile named IPOSE-Call-Server. In the
General parameters, the Server Type is set to Call Server. In the IP Address / FQDN field, the
IP Address of IP Office LAN 1 interface in the sample configuration is entered. This IP address
15 10.64.19.170. Under Port, 5061 is entered, and the Transport parameter is setto TLS. The
TLS profile sbce8_70Client created in Section 7.2.3 is selected for TLS Client Profile. If
adding the profile, click Next (not shown) to proceed. If editing an existing profile, click Finish.

Edit SIP Server Profile - General X

Server Type can not be changed while this SIP Server Profile is associated to a Server Flow.
Server Type Call Server v
SIP Domain
DNS Query Type NONEIA »
TLS Client Profile shced_70Client v
Add

IP Address / FQDN Port Transport
10.64.19.170 5061 TLS ¥ | Delete

Finish
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Default values can be used on the Authentication tab, click Next (not shown) to proceed to the
Heartbeat tab. The Avaya SBCE can be optionally configured to source “heartbeats” in the form
of PINGs or SIP OPTIONS towards IP Office. Check the Enable Heartbeat box and select
OPTIONS from the Method drop-down menu. Select the desired frequency that the SBCE will
source OPTIONS towards IP Office.

SIP Servers: IPOSE-Call-Server

Rename || Clone || Delete

General H Authentication H Heartbeat ‘ ‘ Registration H Ping ‘ ‘ Advanced ‘

Enable Heartbeat <
Method OPTIONS
Frequency 60 seconds
From URI SBCE@silipose.customera.com
To URI IPOSE@silipose.customera.com
Edit

On the Advanced tab, Enable Grooming is check and the Interworking Profile is set to
Enterprise Interwork created in Section 7.6.1 for IP Office.

SIP Servers: IPOSE-Call-Server
Rename || Clona || Delete
General H Authentication H Heartbeat ‘ ‘ Registration H Ping ‘ ‘ Advanced ‘
Enable DoS Protection
Enable Grooming 7
Interworking Profile Enterprise Intarwork
Signaling Manipulation Script None
Securable
Enable FGDN
Tolerant
URI Group None
Edit
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7.7.2. SIP Server Profile = AT&T

To add a SIP Server Profile for AT&T, navigate to Services - SIP Servers and click Add.
Enter a descriptive name for the new profile and click Next.

Add Server Configuration Profile

ATT-TollFree-irk-svr

Next

The following screens illustrate the SIP Server Profile ATT-TollFree-trk-svr. In the General
parameters, the Server Type is set to Trunk Server. In the IP Address / FQDN fields, the
AT&T-provided network border element IP address is entered. This is 192.168.225.210. Under
Port, 5060 is entered, and the Transport parameter is set to UDP. If adding the profile, click
Next (not shown) to proceed. If editing an existing profile, click Finish.

Edit SIP Server Profile - General X

Server Type can not be changed while this SIP Server Profile is associated to a Server Flow.
Server Type Trunk Server
SIP Domain
DNS Query Type NONE/A ¥
TLS Client Profile None
Add
IP Address / FQDN Port Transport
192.168.225.210 5060 UDP v | Delete
Finish

Default values can be used on the Authentication tab, click Next (not shown) to proceed to the
Heartbeats tab. The Avaya SBCE can be configured to source “heartbeats” in the form of SIP
OPTIONS towards AT&T. This configuration is optional. Independent of whether the Avaya
SBCE is configured to source SIP OPTIONS towards AT&T, AT&T will receive OPTIONS
from the IP Office site as a result of the Check OOS parameter being enabled on IP Office (see
Section 5.5.2). When IP Office sends SIP OPTIONS to the inside private IP Address of the
Avaya SBCE, the Avaya SBCE will send SIP OPTIONS to AT&T. When AT&T responds, the
Avaya SBCE will pass the response to IP Office.
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Select OPTIONS from the Method drop-down menu. Select the desired frequency that the
SBCE will source OPTIONS. The From URI and To URI may be filled in to configure easily
identifiable URIs to appear in SIP OPTIONS sourced by the Avaya SBCE. If adding a new
profile, click Next to continuing to the Advanced settings.

SIP Servers: ATT-TollFree-trk-svr

Rename || Clone || Delete

General ‘ ‘ Authentication ‘ ‘ Heartbeat H Registration H Ping H Advanced ‘

Enable Heartbeat r
Method OPTIONS
Frequency 300 seconds
From URI SBCE@avaya.com
To URI ATTBE@att.com
Edit

On the Advanced tab, Enable Grooming is not used for UDP connections and is left
unchecked. The Interworking Profile is set to AT T-Interworking created in Section 7.6.2 for
AT&T.

SIP Servers: ATT-TollFree-trk-svr

Rename || Clone || Delete

General ‘ ‘ Authentication ‘ ‘ Heartbeat H Registration ‘ ‘ Ping H Advanced ‘
Enable Do3 Protection
Enable Grooming
Interworking Profile ATT-Interworking
Signaling Manipulation Script Mone
Sacurable
Enable FGDN
Tolerant
URI Group Mone
Edit
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7.8. Routing Profiles

Routing profiles define a specific set of packet routing criteria that are used in conjunction with
other types of domain policies to identify a particular call flow and thereby ascertain which
security features will be applied to those packets. Parameters defined by Routing Profiles include
packet transport settings, name server addresses and resolution methods, next hop routing
information, and packet transport types. Separate Routing Profiles were created in the reference
configuration for IP Office and AT&T IPTF service.

7.8.1. Routing Profile — IP Office

To add the Routing Profile for the IP Office, navigate to Configuration Profiles = Routing and
select Add. Enter a Profile Name and click Next to continue.

Routing Profile

Profile Name To IPOSE

The following screen shows the Routing Profile To IPOSE created in the sample configuration.
The parameters in the top portion of the profile are left at their default settings. Clicking the Add
button on this screen allows to enter the routing rule at the bottom of the profile. The Priority /
Weight parameter is set to 1, and the IP Office SIP Server Profile, created in Section 7.7.1, is
selected from the drop-down menu. The Next Hop Address (IP address, port and transport) is
automatically selected with the values from the IP Office SIP Server Profile, and Transport
becomes grayed out. Click Finish.

Profile : To IPOSE - Edit Rule X
URI Group * v Time of Day default v
Load Balancing Priority v NAPTR
Transport None ¥ LDAP Routing
LDAP Server Profile MNone ¥ LDAP Base DN (Search) None ¥
Matched Attribute Priority Alternate Routing
Next Hop Priority v Next Hop In-Dialog
Ignore Route Header
ENUM ENUM Suffix
Add
Prioy | DAP Search LDAP Search LDAP Search SIPServer (L Transport
Wei Attribute Regex Pattern Regex Result Profile ext Hop 1653 ranspo
eight
1 IPOSE-C ¥ 10.64.19.170:50 v None v| Delete
Finish
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7.8.2. Routing Profile = AT&T

Similarly, add a Routing Profile to AT&T. The following screen shows the Routing Profile To
ATT IPTF created in the sample configuration. The parameters in the top portion of the profile
are left at their default settings. The Priority / Weight parameter is set to 1, and the AT&T SIP
Server Profile, created in Section 7.7.2, is selected from the drop-down menu. The Next Hop
Address is automatically selected with the values from the AT&T SIP Server Profile, and
Transport becomes greyed out. Click Finish.

Profile : To ATT IPTF - Edit Rule X
URI Group * v Time of Day default v
Load Balancing Priority v NAPTR
Transport Mone ¥ LDAP Routing
LDAP Server Profile None ¥ LDAP Base DN (Search) None ¥
Matched Attribute Priority Alternate Routing
Next Hop Priority ' Next Hop In-Dialog
Ignore Route Header
ENUM ENUM Suffix
Add
Priority
LDAP Search LDAP Search LDAP Search SIP Server Next Hop Add T it
. Attribute Regex Pattern Regex Result Profile ext Hop ress ranspo
Weight
1 ATT-TollF * None  v| Delete
Finish
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7.9. Topology Hiding Profile

The Topology Hiding profile manages how various source, destination and routing information
in SIP and SDP message headers are substituted or changed to maintain the integrity of the
network. It hides the topology of the enterprise network from external networks.

To create the Topology Hiding profiles for IP Office and AT&T, navigate to Configuration
Profiles > Topology Hiding. Click the Add button to add a new profile, or select an existing
topology hiding profile to edit. In the sample configuration, the default profile was cloned for
both IP Office and AT&T. They will later be applied to the Server Flows in Section 7.15.

In the Replace Action column an action of Auto will replace the header field with the IP address
of the Avaya SBCE interface and the Overwrite will use the value in the Overwrite Value.

In the example shown, IPOSE-Topology was cloned from the default. A second profile, SIP-
Trunk-Topology (not shown) was similarly cloned from the default.

EMS Dashboard

Device Management

Backup/Restore

> System Parameters

4 Configuration Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups
Reverse Proxy Policy

> Services

> Domain Policies

> TLS Management

Topelogy Hiding Profiles: IPOSE-Topology

Session Border Controller for Enterprise

Add

Topology Hiding Click here to add a description.
Profiles

default
cisco_th_profile
Enterprise-Topology
SIP Trunk-Topology

IPOSE-Topology

Topology Hiding

AVAYA

Rename || Clone || Delete

Header

To
Record-Route
Refer-To
Request-Line
Via

SDP
Referred-By

From

Criteria

IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain

IP/Domain

Replace Action

Auto
Auto
Auto
Auto
Auto
Auto
Auto

Auto

Edit

Overwrite Value
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7.10. Application Rules

Application Rules define which types of SIP-based Unified Communications (UC) applications
the Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In
addition, you can determine the maximum number of concurrent voice and video sessions the
network will process in order to prevent resource exhaustion.

Select Domain Policies = Application Rules from the left-side menu as shown below. Click
the Add button to add a new profile, or select an existing application rule to edit. In the sample
configuration, the sip-trunk rule was created for IP Office and AT&T. In an actual customer
installation, set the Maximum Concurrent Sessions for the Audio and Video applications to a
value slightly larger than the licensed sessions. For example, if licensed for 150 session set the
values to 200. The Maximum Session Per Endpoint should match the Maximum Concurrent
Sessions.

Device: SBCE8-70 v Alarms  Incidents Statusv Logsv  Diagnostics  Users Settings v Help ¥ Log Out
Session Border Controller for Enterprise AVAYA
EMS Dashboard Application Rules: sip-trunk

Device Management Add Rename || Clone || Delete
Backup/Restore — = e

> System Parameters Application Rules Click here to add a description.

> Configuration Profiles LT Application Rule
> Services default-trunk
4 Domain Policies P — Application Type In Out Maximum Concurrent Sessions ~ Maximum Sessions Per Endpoint
Application Rules ) . Audio " vl 200 200
default-subscriber-high
Border Rules Video
Media Rules default-serverlow
Securiy Rules cefeutsenertigh
Signaling Rules sip-trunk CDR Support Off
Charging Rules .
) RTCP Keep-Alive No
End Point Policy
Groups Edit

Session Policies

7.11. Media Rules

Media Rules define RTP media packet parameters such as prioritizing encryption techniques and
packet encryption techniques. Together these media-related parameters define a strict profile that
is associated with other SIP-specific policies to determine how media packets matching these
criteria will be handled by the Avaya SBCE security product.

To create a Media Rule for the IP Office, select Domain Policies = Media Rules from the left-
side menu. In the sample configuration, the default avaya-low-med-enc rule was cloned for IP
Office, and then modified as shown on the screen below. With the avaya-low-med-enc rule
chosen, click Clone. Enter a descriptive name for the new rule and click Finish (not shown).
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The Media Rule enterprise-med-rule created for the IP Office is shown below.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Media Rules: enterprise-med-rule
Device Management Add Rename || Clone || Delete
Backup/Restore
Media Rules Click here to add a description.
» System Parameters

default-low-med

» Canfiguration Profiles Encryption H Codec Prioritization | ‘ Advanced ‘ Qos

> Services default-low-med-enc
4 Domain Palicies default-high Audio Encryption
Application Rules I Preferred Formats SRIP_AES_CM_120_HMAC_SHA1_80

Border Rules

Media Rules avaya-low-med-enc Encrypted RTCP
Security Rules att-med-rule MKI
Signaling Rules enterprise-med-rule e Any
Charging Rules
Interworking td

End Point Policy

Groups
Session Folcis
> TLS Management Preferred Formats SRTP_AES_GM_120 HMAG_SHA1_80
> Network & Flows
> DMZ Services Encrypted RTCP
» Monitoring & Logging MKI
Lifetime Any
Interveorking <

Miscellaneous

Capability Negotiation =

Similarly, the default default-low-med rule was cloned to create the Media Rule for AT&T.

The Media Rule named att-med-rule used in the sample configuration for AT&T IPTF is shown
below, with the DSCP values EF for expedited forwarding (default value) for Media QoS.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Media Rules: att-med-rule
Device Management Add Rename || Clone | Delete
Backup/Restore
Media Rules Click here to add a description.
> System Parameters

default-low-med

» Configuration Profiles Encryption ‘ | Codec Prioritization | ‘ Advanced | QoS
> Services default-low-med-enc
4 Domain Policies default-high Media QoS Marking
Application Rules ) Enabled v
default-high-enc
Border Rules QoS Type DsCP
Media Rules avaya-low-med-enc
Signaling Rules enterprise-med-rule Audio DSCP EF
Charging Rules
End Point Policy Vidso QoS
Groups Video DSCP EF
Session Policies
Edit
> TLS Management
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7.12. Signaling Rules

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

Clone and modify the default signaling rule to add the proper quality of service to the SIP
signaling. To clone a signaling rule, navigate to Domain Policies = Signaling Rules. With the
default rule chosen, click Clone. Enter a descriptive name for the new rule and click Finish (not
shown). In the sample configuration, signaling rule enterprise sig rule is unchanged from the
default rule.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Signaling Rules: enterprise-sig-rule

Device Management Add Rename || Clene || Delete
Backup/Restore

S
> System Parameters Click here to add a description.

default

> Configuration Profiles General H Requests H Responses || Request Headers H Response Headers || Signaling QoS | ucip
> Services Me-Content-Type-Ch..
+ Domain Poliies i e e —
Application Rules o Requests Allow
enterprise-sig-rule
Border Rules Non-2XX Final Responses Allow
: ATT-TF-408-test-sig
Media Rules Optional Request Headers Allow
Security Rules
Optional Response Headers Allow
Signaling Rules
End Point Policy Requests Allow
Groups
. . Non-2XX Final Responses Allow
Session Policies
> TLS Management Optional Request Headers Allow
> Network & Flows Optional Response Headers Allow
> DMZ Services
> Monitoring & Logging Content-Typs Policy
Enable Content-Type Checks el
Action Allow Multipart Action Allow
Exception List Exception List
Edit

Signaling rule att sig rule was also cloned from the default rule and used for AT&T. The DSCP
value AF41 for assured forwarding (default value) was set for Signaling QoS.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Signaling Rules: att-sig-rule

Device Management Add Rename | Clone || Delete
Backup/Restore

SRR
> System Parameters Click here 10 add a description

default

> Configuration Profiles General H Requests H Responses | ‘ Request Headers H Response Headers || Signaling QoS ‘ ’H‘

> Services No-Centent-Type-Ch

4 Domain Policies att-sig-rule Signaling QoS rl
Application Rules enterprise-sig-rule QoS Type Dscp
Border Rules bscp AFa1
Media Rules ATT-TF-408-test-sig
Security Rules Edit
Signaling Rules
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7.13. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to a Server Flow in Section 7.15.

To create a new policy group, navigate to Domain Policies - Endpoint Policy Groups and
click on Add as shown below. The following screen shows the enterprise policy created for IP
Office. The details of the non-default rules chosen are shown in previous sections.

EMS Dashboard

Device Management

Backup/Restore

> System Parameters

> Configuration Profiles

> Services

4 Domain Policies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Charging Rules
End Point Policy
Groups
Session Policies

> TLS Management

> Network & Flows

Session Border Controller for Enterprise

AVAYA

Policy Groups: enterprise-policy
Add Rename || Clone || Delste
Policy Groups Click here to add a description_

defauli-low

default-low-enc

default-med

Click here to add a row description.
Policy Group

default-med-enc

default-high Order Border Signaling

Application

default-high-enc enterprise-

med-rule default-low

default

.y enterprise-sig-
1 sip-trunk ;

ule
avaya-defow-enc

Charging

None

Summary

Off Edit

avaya-def-high-subsc...
avaya-def-high-server
att-policy-group

enterprise-policy

The following screen shows the att-policy-group created for AT&T. The details of the non-
default rules chosen are shown in previous sections.

EMS Dashboard
Device Management
Backup/Restare

» System Parameters
» Configuration Profiles

Session Border Controller for Enterprise

Policy Groups: att-policy-group
Add

AVAYA

Rename || Clone || Delete

Policy Groups Click here to add a descriplion.

default-low

Click here to add a row description.

> Services default-low-anc
4 Domain Policies default-med Policy Group
Application Rules
ep default-med-enc Summary
Border Rules FTER i
Media Rules default-high Order Application Border Media Security Signaling Charging o on
Security Rules default-high-enc 1 sip-irunk default attmed-rle  default-low att-sig-rule None off Edit
Signaling Rules avaya-def-low-enc
Charging Rules avaya-def-high-subsc.
End Point Policy
Groups avaya-def-high-server
Session Policies att-policy-group
» TLS Management ) "
enterprise-policy
> Network & Flows
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7.14. Advanced Options

In Section 7.4, the media UDP port ranges required by AT&T are configured (16384 — 32767).
However, by default part of this range is already allocated by the Avaya SBCE for internal use
(22000 - 31000). The following steps reallocate the port ranges used by the Avaya SBCE, so the
range required by AT&T can be defined as shown in Section 7.4.

Step 1 - Select Device Specific Settings = Advanced Options from the menu on the left-hand
side.

Step 2 - Select the Port Ranges tab.

Step 3 - In the Signaling Port Range row, change the range to 12000 — 16380

Step 4 - In the Config Proxy Internal Signaling Port Range row, change the range to 42000 —
51000.

Step 5 — In the Listen Port Range row, change the range to 6000 — 6999.

Step 6 — In the HTTP Port Range row, change the range to 51001 — 62000.

Step 7 - Select Save. Note that changes to these values require an application restart (see Section

7.1).
Session Border Controller for Enterprise AVAYA
EMS Dashboard Advanced Options
Device Management
Backup/Restore
. System Parameters Periodic Statistics ‘ | Feature Control ‘ | SIP Options ‘ | Network Options H Port Ranges || RTCP Monitoring ‘ | Load Monitoring |
> Configuration Profiles
. Services Changes to the settings below require an application restart before taking effect. Application restarts can be issued from Device Management.
> TLS Management Signaling Port Range 12000 - 16380
4 Network & Flows
Network Management Config Proxy Internal Signaling Port Range 42000 -|51000
Media Interface
Signaling Interface (s e R 5000 |-|6999
End Paoint Flows
Session Flows
Advanced Options HTTP Port Range 51001 - 62000
> DMZ Services
> Monitoring & Logging laSave|
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7.15. End Point Flows - Server Flow

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URIs, etc.)
is used to determine which flow it matches. Once the flow is determined, the flow points to a
policy which contains several rules concerning processing, privileges, authentication, routing,
etc. Once routing is applied and the destination endpoint is determined, the policies for this
destination endpoint are applied. The context is maintained, so as to be applied to future packets
in the same flow.

Create a Server Flow for IP Office and AT&T IPTF service. To create a Server Flow, navigate to
Networks & Flows = End Point Flows. Select the Server Flows tab and click Add (not
shown).

The following screen shows the flow named ATT IPTF viewed from the sample configuration.
This flow uses the interfaces, polices, and profiles defined in previous sections.

View Flow: ATT IPTF X

~ Criteria - Profile
Flow Mame ATT IFTF Signaling Interface Outside-Signaling
Server Configuration  ATT-TollFree-trk-svr Media Interface Outside-Media
URI Group * Secondary Media Interface MNone
Transport " End Point Policy Group aft-policy-group
Remote Subnet * Routing Profile To IPOSE
Received Interface Inside-Sig-TollFree-41 Topology Hiding Profile _?(l)l;t;ll'lr]%r;k.
Signaling Manipulation Script  MNone
Remote Branch Office Any
Link Monitoring from Peer
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Once again, select the Server Flows tab and click Add. The following screen shows the flow
named IPO — TollFree viewed from the sample configuration. This flow uses the interfaces,

polices, and profiles defined in previous sections.

View Flow: IPO Toll Free X

~ Profile

- Criteria
Flow Mame

Server Configuration
URI Group
Transport

Remote Subnet

Receivad Interface

IPO Toll Fres

IPOSE-Call-Server

*

COutside-Signaling

Signaling Interface

Media Interface

Secondary Media Interface
End Point Policy Group
Routing Profile

Topology Hiding Profile
Signaling Manipulation Script
Remote Branch Office

Link Monitoring from Peer

Inside-Sig-
TollFree-41

Inside-Media-
TollFree

Mone
enterprise-policy
To ATT IPTF
IPOSE-Topology
Mone

Any
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8. AT&T IP Toll Free Service Configuration

AT&T provides the IPTF service border element IP address, the access DID numbers, and the
associated DNIS digits used in the reference configuration. In addition, the AT&T IPTF features,
and their associated access numbers, are also assigned by AT&T. AT&T requires that the Avaya
SBCE public (B1) IP address be provided to the IPTF service, as part of the provisioning
process. For more information, consult reference [13].

9. Verification Steps

The following procedures may be used to verify the Avaya IP Office Release 11.0 and Avaya
SBCE Release 8.0 with the AT&T IPTF service configuration.

9.1. AT&T IP Toll Free Service
The following scenarios may be executed to verify functionality with the AT&T IPTF service:

Place inbound calls, answer the calls, and verify that two-way talk path exists. Verify that
the calls remain stable for several minutes and disconnects properly.

Incoming calls using the G.729A and G.711 ULAW codecs.

Verify basic call functions such as hold, transfer, and conference.

Place an inbound call to a telephone, but do not answer the call. Verify that the call
covers to voicemail (e.g., Voicemail Pro). Retrieve the message either locally or from
PSTN.

Using the appropriate IPTF access numbers and codes, verify the “Legacy Transfer
Connect” DTMF initiated features.

Inbound fax using T.38 or G.711. See Section 2.2 for limitation.

SIP OPTIONS monitoring of the health of the SIP trunk.
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9.2. Avaya SBCE
This section provides verification steps that may be performed with the Avaya SBCE.

9.2.1. Incidents

The Incident Viewer can be accessed from the Avaya SBCE top navigation menu as highlighted
in the screenshot below.

Device: SBCEB-70v Alarms Incidents Status¥ Logsv  Diagnostics Users Setings v Help ¥ Log Out
Session Border Controller for Enterprise AVAYA
EMS Dashboard Dashboard

Backup/Restore
System Time 075658 AM MDT Refresh EMS
> System Parameters

Version 8.0.0.0-19-16991 SBCES-70

> Configuration Profiles

Use the Incident Viewer to verify Server Heartbeat and to troubleshoot routing failures.

Incident Viewer AVAYA
Davice | All v | Category | All v Clear Filters | Refresh || Generate Report |
Displaying results 1006 to 1020 out of 2000

D Device Date & Time Category Type Cause

781947280285655 SBCEE-T0 Jul 23, 2019 9:09:20 AM Policy Server Heartbeat Heartheat Successful, Server is UP
781947250070325 SBCES-T0 Jul 23, 2019 9:08:20 AM Policy Message Dropped Mo Subscriber Flow Matched
781947224706435 SBCES-70 Jul 23, 2019 9:07:29 AM Policy Message Dropped No Subscriber Flow Matched
781947217172299 SBCE&-T0 Jul 23, 2019 9:07:14 AM Policy Message Dropped No Subscriber Flow Matched
781947211142544 SBCE&-T0 Jul 23, 2019 9:07:02 AM Policy Message Dropped No Subscriber Flow Matched
781947193703693 SBCES-70 Jul 23, 2019 9:06:27 AM Policy Server Heartbeat Heartheat Successful, Server is UP
7819471936926 SBCEE-T0 Jul 23, 2019 9:06:27 AM Policy Server Heartbeat Heartheat Successful, Server is UP
781947074710316 SBCES-70 Jul 23, 2019 9:02:29 AM Policy Message Dropped MNo Subscriber Flow Matched

9.2.2. Server Status

The Server Status can be access from the Avaya SBCE top navigation menu by selecting the
Status menu, and then Server Status. This functionality requires Heartbeat to be enabled on the
SIP Server Profile, as configured on Section 7.7.

Device: SBCEB-70~¥ Alarms Incidents Status¥ Logs+¥ Diagnostics Users Settings ¥ Help ¥ Log Out
SIP Statistics

Session Border ContriiZEEEETS

User Registrations

Server Status

EMS Dashboard Dashboara
Backup/Restore
System Time 08:06:34 AM MDT Refresh EMS
> System Parameters
» Configuration Profiles LT 6.0.0.0-18-16991 SBCES-70
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9.2.3. Tracing

To take a call trace, navigate to Monitoring & Logging = Trace and select the Packet
Capture tab. Populate the fields for the capture parameters and click Start Capture as shown
below.

Session Border Controller for Enterprise AVAYA

EMS Dashboard Trace: SBCE8-70
Device Management
Backup/Restore

> System Parameters Packet Capture | | Captures.
» Genfiguration Profiles e Gy Ea O ey

> Services p— —

> Domain Policies

> TLS Management Interface Any v

> Network & Flows Local Address o
IPFer]

> DMZ Services
4 Monitoring & Logging
SNMP

Remote Address

Protocol Al v
Syslog Management
Debugging Maximum Number of Packets to Capture 10000
Trace Capture Filename
us r|pg the name of an existing capture will overwrite it. testi pcap
Log Collection
Do$S Learning Start Capture Clear
CDR Adjunct

When tracing has reached the desired number of packets the trace will stop automatically, or
alternatively, hit the Stop Capture button at the bottom.

Session Border Controller for Enterprise AVAYA
> Llopal Farameters -| Trace: SBCE

> Global Profiles

» PPM Services

> Domain Policies Packet Capture | | Captures.

> TLS Management SBCE

A packet capture is currently in progress. This page will automatically refresh until the capture completes.

4 Device Specific Settings
Network Packet Capture Configuration
Management Status In Progress
Media Interface
. Interface B2 v
Signaling Interface
End Point Flows I—P‘?“;‘a‘nf‘dd'ess All
Session Flows
Remote Address
> DMZ Services *, ":Port, IP, IP:Port
TURN/STUN Protocol UDP -
Service
SNMP Maximum Mumber of Packets to Capture 10000
Syslog Management Capture Filename
. Using the nama of an
Advanced Options o
4 Troubleshooting Stop Capture
Debugging

protocol-trace-att_pcap

existing capture wil ovarwite 7

Trace

Dos
Learning
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Select the Captures tab to view the files created during the packet capture.

Session Border Controller for Enterprise AVAYA
EMS Dashboard Trace: SBCES-70
Device Management
Backup/Restore
b System Parameters Packet Capture | | Captures
© Gonfiguration Profiles
b Services
File Name File Size (bytes) Last Modified
» Domain Policies
» TLS Management test1_20190724082944 pcap 696,320 July 24, 2019 8:30:26 AM MDT Delete

» Network & Flows

v DMZ Services

< Monitoring & Logging
SNMP
Syslog Management
Debugging

Trace

The packet capture file can be downloaded and then viewed using a Network Protocol Analyzer
like Wireshark.

9.3. Avaya IP Office
The following items may be used to analyze/troubleshoot Avaya IP Office operations.

9.3.1. System Status Application

The Avaya IP Office System Status application can be used to verify the service state of the SIP
line. From the IP Office Manager application, select File > Advanced = System Status.
Under Control Unit IP Address select the IP address of the IP Office system under verification.
Log in using the appropriate credentials.

Online | offiine

Logon

(T NTGTIE Y 10.64.19.170

Proxy Server Address: RIS

Services Base TCP Port: Elil:sE]

(I TE 1 Y [T Automatic

(U T [ Admini strator

Password: (1JIZITITIT.
B Auto reconnect
Secure connection

Bl Websocket connection
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After logging in, select Trunks - Line: 15 from the left navigation menu. (SIP Line 15 is
configured in Section 5.5). A screen such as the one shown below is displayed. In the lower left,
the Trace All button may be pressed to display tracing information as calls are made using this
SIP Line. The Ping button can be used to ping the other end of the SIP trunk (e.g., the Avaya
SBCE).

IP Office System Status

Status | Utilization Summary Alarms

SIP Trunk Summary

Line Service State: In Service
Peer Domain Name: sip:/f10.64.91.41
Resolved Address: 10.64.91.41
Line Number: 15
Number of Administered Channels: 10
Number of Channels in Use: 1}
Administered Compression: G729 A, GT11Mu
Enable Faststart: off
Silence Suppression: off
Media Stream: Best Effort
Layer 4 Pratocal: TS
SIP Trunk Channel Licenses: 10 . -
SIP Trunk Channel Licenses in Use: a
SIP Device Features: REFER (Incoming and Outgoing)
me r Other Party on f 1 ] Transmit
ate igits Il elay Jitter e Jitter
2 Idie 08:06:48
3 Idle 08:08:37
4 Idie 2 days 04,
5 Ide 2days 04,
3 Ide 2 days 04,
7 Ide 2 days 04,
E 1die 2 days 04,
9 Idie 2 days 04,
10 Ide | 2days04...
Trace Trace All Pause Ping Call Details Graceful Shutdown Force Out of Service Print... Save As...

Select the Alarms tab and verify that no alarms are active on the SIP line.

Alarms

Status  Utilization Summary

Alarms for Line: 15 SIP sip://10.64.91.41

Last Date Of Error Occurrences

Error Description
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9.3.2. System Monitor Application

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs = IP Office -
Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

EJ: Avaya IP Dffice SysMonitor - [STOPPED]
Flle Edit “iew Filkers Status Help

=8| »lET] X[y @ ¥l
| t 44

Start/Stop Trace Select
Trace Options Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting to the desired color.

1 | weN | wen | cm | sow | Jade
ATM | cal | DTE | EConf | FrameRely | GOD | H323 | Interface
ISDN | KeyeLamp | Direstory | Media | FFP | A2 | Routing | Services  SIP | System

Events
W Sip [Toe = [ NAT [~ SIP Dect
[ IcE
Packets
I~ SIP Reg/Dpt R [ SIP Misc R [ SIP Stim Ry
[~ SIPReg/Opt Tx [ SIP Mise Tx [ SIP Stim Tx
¥ SIP Call Rx [~ CmMotify Rix [~ STUN Ry
[ SIPCall Tx [ Cm Moty Tx [ STUN T
[ ICE Dala
¥ Sip Rx IF Filer {rnn.nnn, nnn.nnn)
W Sip Tx
Dofault All|  Clear Al | TabCoari | Tabsetan| ok | Concel
sovefe | LoadFie | LosdParialFie|  SelectFik |
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10. Conclusion

As illustrated in these Application Notes, Avaya IP Office Release 11.0 and the Avaya Session
Border Controller for Enterprise Release 8.0 can be configured to interoperate successfully with
the AT&T IP Toll Free service using AVPN or MIS/PNT transport connections, utilizing
service features listed in Section 2.1, and within the limitations described in Section 2.2.

The reference configuration shown in these Application Notes is representative of a basic
enterprise customer configuration and is intended to provide configuration guidance to
supplement other Avaya product documentation. It is based upon formal interoperability
compliance testing as part of the Avaya DevConnect Service Provider program.

11. Additional References

Avaya:
Avaya product documentation is available at http://support.avaya.com. Additional Avaya IP
Office information can be found at: http://marketingtools.avaya.com/knowledgebase/

[1] Deploying IP Office Platform Server Edition Solution, Release 11.0, May 2018
[2] IP Office Platform 11.0, Deploying Avaya IP Office Servers as Virtual Machines, April 2019
[3] IP Office Platform 11.0, Deploying Avaya IP Office Essential Edition (IP500 V2), February
20109.
[4] Administering Avaya IP Office Platform with Manager, Release 11.0, February 2019.
[5] Administering Avaya IP Office Platform with Web Manager, Release 11.0 FP4, February
20109.
[6] IP Office Platform 11.0, Administering Avaya IP Office Platform Voicemail Pro, February
20109.
[7] Planning for and Administering Avaya Equinox for Android, iOS, Mac and Windows,
Release 3.6, July 2019
[8] Using Avaya Equinox for IP Office, Release 11.0, August 2019
[9] IP Office Platform 11, IP Office SIP Phones with ASBCE, Issue 03f, April 2019
[10] Deploying Avaya Session Border Controller in Virtualized Environment. February 2019.
[11] Administering Avaya Session Border Controller for Enterprise, April 20109.
[12] RFC 3261 SIP: Session Initiation Protocol. https://www.ietf.org/rfc/rfc3261.txt

AT&T IPTF Service:

[13] AT&T IP Toll Free Service description -
https://www.business.att.com/products/ip-toll-free.html
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are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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